AoIP User Manual

AES67 / ST 2110-30/ ST 2022-7
IP Streaming Configuration

Software Version: 3.08.xx
Manual Version: 1.7 20241112
November, 2024




AolP User Manual v1.7

Table of Contents

Part |

© 00 N O 0o A W DN B

(=Y
o

e
A W N R

AESG67 Introduction 3
L€ Lo TSTST= LA« 1 =T 12 5
ADOUL AESBT7 / ST 2100 .ottt e e e e e e e e e et e e e anes 6
101 Lo Tod ¢ o [R U PSPPSR 8
Discovery, Advertisement and CONrol .......c..couiiiiiiiiiii e 12
CodeC AESHB7/ST2110-30 SEEUP vevueeeieinieieiii ettt e ee e e e et e e et eeeat s e e eeaa e e eaae e eeanes 19
Configuring AES67 Sources and DestinationS .........c..iviiiiiiiiiiiiiiieii e 28
LT o 1 I = o= N 40
WheatNet-1P StrEaMIING ...c.. it e e e et e e e aeanas 42
LR AN N NS = T 411 o 57
Enable Livewire and Use Pathfinder ...........oouuiiiiiiiiiii e 61
(D= L =R 4 =TT 1] oo R 76
LAWO AESB7 SEFEAIMING ..ueveuieiinieiiieeiieteteeet e eet s eeat e et e eet s eeaaaeetnaeeaneeeneeetnaeesnaeennaes 85
Troubleshooting AES67 and WheatNet ..........o.oiiiiiiiiiii e 90
Trademarks and Credit NOLICES .....oiuuiiiiie e e 92
Index 93

© Tieline Research Pty. Ltd. 2024



AolP User Manual v1.7 3

1 AESG7 Introduction

About AES67

AES67 is a technical standard developed by the Audio Engineering Society (AES) with
interoperability guidelines for Audio-over-IP (AolP). It is supported by major AolP vendors like
Wheatstone, Telos, Ravenna, Dante and others, and supports the streaming of audio between
these different systems. Tieline codecs are used to transport audio between AES67 compatible
networks and studios and using AES67 inputs and outputs facilitates inter-studio routing of high
quality AolP.

The AES67 standard defines requirements for synchronizing clocks using IEEE 1588-2008
Precision Time Protocol (PTPv2). It also defines setting of QoS media traffic priorities and
initiating media streams using standard internet protocols. The standard also defines the audio
sample format and sample rate, the number of supported channels, plus latency, buffering and the
size of IP data packets. It does not define device discovery, connection management and media
configuration protocols.

Introduction

Tieline Gateway and Gateway codecs are AES67 compliant and therefore capable of connecting
to AolP networks such as:

Wheatstone WheatNet-IP using optional WheatNet-IP card installed at purchase.
Wheatstone in AES67 compatibility mode.

Axia Livewire+

RAVENNA

Dante using an optional Dante card installed at purchase.

Dante in AES67 compatibility mode.

ogkrwnE

Other G6 codecs such as the MPX I, MPX II, Bridge-IT Il and Bridge-IT XTRA Il natively support
RAVENNA and Livewire+, but do not provide options to install WheatNet-IP or Dante cards, and
therefore must connect to these AolP networks using AES67 compatibility mode if required.

AES67 compatibility makes it simple for different devices to use common configuration settings and
stream audio between them. Similar to how different brands of codecs are configured to connect
using SIP for interoperability, AES67 compliant audio products can stream audio between each
other using common streaming configuration parameters. The codec is also compliant with ST
2110-30 for system timing/synchronization and PCM digital audio transport. This allows the codec
to operate in live production, playout and other media applications, where real-time audio, video
and ancillary data needs to remain independent yet co-timed, allowing independent streams to be
synchronized. The SMPTE ST 2110 standards are based on AES67 so can work together. The
configurable elements include:

Audio Sampling Rate

Audio Sampling Depth.

Packet Time.

Number of Channels streamed.

El e

In addition, the SDP values defined in ST 2110-30 provide standard order for individual channels
within the IP packets. E.g. for stereo and surround sound channels. Plus, ST 2110-30 also defines
a set of six compliance levels for devices receiving audio streams. The codec supports A, AX, B
and BX.

© Tieline Research Pty. Ltd. 2024
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1 millisecond Packet Time 125 microseconds Packet Time

Level 48 kHz 96 kHz 48 kHz 96 kHz

A 1to 8

AX 1to8 1to 4

B 1to 8 1to 8

BX 1to 8 1to4 1to 8 1to 8

C 1to 8 1to 64

CX 1to8 1to 4 1to 64 1to 32

Note: Only the AolP 1 port on the Gateway and Gateway 4 codec rear panel can be used to

connect to WheatNet-IP networks. All AolP configuration settings are configured in the AolP menu
in the HTML5 Toolbox Web-GUI.

© Tieline Research Pty. Ltd. 2024
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1.1 Glossary of Terms

AES67

A technical standard for audio over IP and audio over Ethernet (AoE)
interoperability developed by the AES. It is a layer 3 protocol suite
facilitating interoperability between IP-based audio networking systems.
Proprietary AolP systems like WheatNet-IP, RAVENNA, Livewire, and
Dante offer compatibilty modes for interoperability using AES67
standards.

API An Application Programming Interface (API) is a software intermediary
allowing two applications to talk to each other.

Dante Dante is a proprietary AolP system developed by Audinate which also
supports AES67 streaming.

Destination An AolP Destination is an endpoint for receiving an AES67 or ST 2110-30
stream.

DSCP The Differentiated Services Code Point or Diffserv Value is a field in an IP
packet header for prioritizing data when traversing IP networks. This is
often used in AES67 streaming.

Ember+ An open standard control protocol developed by Lawo which allows a third
party application to gain access to device parameters.

Flow The term Dante uses to describe an audio stream over an AolP network.
E.qg. Source flow.

Follower Devices that are synced to an elected PTP Leader Clock over an AolP
network.

GPIO A General Purpose Input/Output is a customizable pin on an integrated
circuit that can be controlled by software. A GPI is a General Purpose
Input and a GPO is a General Purpose Output.

IGMP A communications protocol used by hosts and adjacent routers on IPv4

networks to establish multicast group mships to |Pv4 routers.

IGMP snooping

The process of listening to IGMP network traffic for delivery of IP
multicasts. Network switches with IGMP snooping maintain a map of
which links need which IP multicast transmission. Multicasts may be
filtered to conserve bandwidth on links.

Livewire+ AES67

Livewire+ is a proprietary protocol from the Telos Alliance which is the
second-generation of Livewire. It facilitates AES67 devices connecting
directly to Livewire+ AES67 networks to exchange audio streams.

Multicast

Efficient one to many streaming of IP audio using multicast IP addressing.

NMOS

Networked Media Open Specifications (NMOS) delivering Discovery and
Registration to ensure that parts of a networked media system can find
each other. NMOS also provides connection management and audio
channel mapping to device 1/O channels.

Primary Leader

The primary source of synchronization for clock distribution via PTP.

(SMPTE ST2022-7)

Clock

PTP The general class clock distribution protocol standardized in IEEE 1588-
2002, IEEE 1588-2008 and IEEE 802.1AS-2011. PTP syncing requires a
leader clock source (often an installed PTP primary leader clocking
device) with clocking replicated on synced devices.

RAVENNA RAVENNA is an open technology developed by ALC NetworX for
discovery and control. It is AES67 and SMPTE ST 2110 compliant.

Redundant Redundant AolP streaming, also known as hitless merge or Seamless

Streaming Protection Switching, is a redundancy mechanism whereby two streams of

identical RTP packets are streamed over diverse paths. The objective is to
seamlessly reconstruct a single perfectly reconstructed output stream
based on the receipt of two potentially network impaired input streams.

SAP

SAP (Session Announcement Protocol) is a discovery protocol used by
Dante to distribute SDP descriptions to receivers, enabling simplified

© Tieline Research Pty. Ltd. 2024
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1.2

connection management for multicast streaming. Settings are also
available in other devices such as Livewire xNodes.

Signal In WheatNet-IP a Signal is what defines a Source or Destination

Source An AolP Source in the codec is an AES67 stream sent by the codec to an
AES67 LAN.

Time To Live TTL is the setting used in muliticast servers to ensure data packets have a

(TTL) finite life and don't cause congestion over networks. Each time a packet

passes through a router it reduces by 1 until it reaches zero, at which point
a router will no longer pass the packet.

WheatNet-IP Proprietary IP protocol and networking system enabling AolP audio
streams to be intelligently distributed to devices across scalable networks.
Compatibility mode also available for AES67 device interoperability.

About AES67 / ST 2110

About AES67 Streams

The AESG67 interoperability standards allow IP audio streaming to multiple devices simultaneously
and efficiently. The standard specifies essential configuration parameters and each manufacturer
has it's own mechanism to manage and configure AES67 settings. For example, Tieline uses the
Toolbox Web-GUI and Wheatstone uses Navigator software to configure WheatNet-IP AES67
settings.

Session Data Information

To connect an AES67 audio stream a node requires session information for stream connection
management. The AES67 and ST 2110-30 standards support Session Description Protocol (SDP)
for configuring the number of audio channels per stream, encoding format, bits per sample,
sampling frequency and number of samples in a packet. Session discovery is not included in the
standard.

The AES67 standard provides a way for devices transmitting streams to encapsulate all the
multicast address, IP address, port, packet timing and format information about a particular stream
using an SDP file. This file provides information in a standardized way and is supported by Tieline
codecs. SDP information can be generated by WheatNet-IP Blades and Telos xNodes and
simplifies the process of configuring AolP streams by copying data from one device into another.

Multicasting

A unique multicast destination address is used to identify a stream over an AolP network. Multicast
routers replicate packets and send them to network devices that want to receive them. There is a
large number of multicast IP addresses available and Tieline 'Source' multicast addresses use the
range 239.3.3.0 to 239.3.3.7 to send 8 streams by default.

Normally the devices streaming audio to a Tieline codec will provide a destination multicast
address to enter into the codec for each stream. By default, Tieline codec destination streams are
populated with multicast addresses in the range 239.33.1.0 to 239.33.1.15. It is also possible to
receive a stream on multiple Destinations using the same multicast IP address.

It is important to create a multicast address plan to allow simple identification and management of
multiple streams. In a studio there will likely be many AES67 devices and it is very important to
document which devices are transmitting and receiving streams from which addresses. Different
manufacturers and devices use different auto-assigned multicast addresses. For example,
Wheatnet uses a second octet of .192 in multicast addresses, so they appear as 239.192.XXX.XXX.

Important Note: The default destination multicast address will normally be configured by
the device streaming audio to the Tieline codec. Verify this address with the network IT
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administrator and then place the correct address into the Address text box in the AES67
Destinations panel.

Unicasting

In the AES67 standard unicasting is supported using SIP for connection management as defined in
RFC3261. SDP is used to configure information about the stream, including the encoding format,
bits per sample, sampling frequency and number of samples in a packet. Note: Not supported in
current firmware release.

IGMP

IGMP is a communications protocol used by codecs and other hosts and adjacent routers on IPv4
networks to establish multicast group memberships to IPv4 routers. IGMP support allows network
filtering of undesired multicasts. The codec supports both IGMPv2 and v3. The default is IGMPv3.
Select IGMPV2 if an AES67 network requires this configuration. IGMPv3 should be selected for ST
2110-30 network compatibility. IGMP snooping is the process of listening to IGMP network traffic
for delivery of IP multicasts. Network switches supporting IGMP snooping maintain a map of which
nodes require IP multicast transmissions. In this way multicasts can be filtered across networks to
conserve bandwidth on links between nodes.

Ports

The AES67 standard recommends using port 5004 as the default port for RTP data streams. Port
5005 is recommended as the default RTCP port. Devices sending and receiving data may use
other ports from 1024 to 65535 as well.

Routers

Managed switches are normally used and recommended for AES67 network routing of audio
streams. These switches allow QoS DSCP/DiffServ packet prioritization and can usually be
configured using a web interface. DiffServ is a framework for classification and differentiated
treatment of network traffic. DiffServ operates on classes of traffic rather than on individual traffic
flows. Per-hop behavior (PHB) is fundamental to and at each router or switch, traffic is classified
and retransmitted according to that classification. When network congestion occurs, higher priority
traffic is retransmitted promptly while lower priority traffic waits in buffers inside network
equipment and may be discarded altogether.

© Tieline Research Pty. Ltd. 2024
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1.3

Clocking

AolP Clocking

AES67 and ST 2110-30 AolP networks require devices to be synchronized to a common external
clock source using IEEE 1588-2008 Precision Time Protocol (PTPv2). One device on a network
will need to function as the 'Primary Leader' clock and all other devices will sync to this across the
network. Most of the time a specialized PTP leader clock, synced to GPS for timing reference, is
used to enable precise timing accuracy lower than 1 microsecond in many instances. Before
enabling AES67 streaming it is necessary to ensure the codec is synced to a PTP leader clock
source which is running. Most of the time the default settings will work fine. The codec can also act
as the Primary Leader PTP clock source. Tieline recommends no more than 10 PTP followers are
used in this mode. It is also possible to select Livewire as the AolP clock source.

Tieline codecs support packet timing from 125 microseconds to 5 milliseconds. WheatNet-IP uses
250 microsecond packet timing by default and this is also supported by Telos xNodes and many
other AES67 devices. At the time of writing Dante does not support this packet size and neither do
Comrex AES67 codecs. The 1.25 millisecond (surround streams) frame size is unique to Livewire.

Sample Rates

The AES67 standard supports 44.1kHz, 48kHz and 96kHz sampling frequencies and most of the
time AolP systems run using 48kHz, 24 bit PCM digital audio. The rate of the media clock should
also be the same as the sampling frequency. AES67 compatible devices should support:

e 16 bit, 44.1kHz sampling.
e 16 bit and 24 bit, 48kHz sampling.
e 24 bit, 96kHz sampling.

Important Note: It is not possible to enable Livewire as a service if the sample rate is not
configured as 48kHz. If Livewire is running the sample rate cannot be changed from
48kHz.

PTP Settings

PTP Domain Number

A domain is an interacting set of clocks that synchronize to each other using PTP. Clocks are
assigned to a domain using the Domain number and the default domain is 0 which is usually ok
unless there is a requirement for multiple clock domains in a network. Adjust as required when on a
network with multiple leader clocks in different domains.

© Tieline Research Pty. Ltd. 2024
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PTP Delay Mechanism

PTP provides three different methods of calculating delay within a network: End-to-End (E2E),
End-to-End Hybrid (E2E Hybrid), and Peer-to-Peer (P2P).

The default setting is usually E2E and this is automatically configured in the codec. If connected to
a large PTP network without boundary clocks, End-to-End Hybrid mode may sometimes be
preferred to support other AolP devices that do not support delay request loads. This mode is
more efficient with regard to PTP messages. It includes a mix of multicast and unicast PTP
messages, to avoid follower clocks being bombarded by delay requests and responses.

Time to Live (TTL)

To avoid network congestion Time to Live configures the number of times a packet is allowed to
pass through a multicast router before it will no longer pass the packet.

Announce Interval

The Announce Interval is configured by a PTP Leader and sets the announce message rate for a
Precision Time Protocol (PTP) follower.

Announce Receipt Timeout

Use the Announce Receipt Timeout setting to configure the timeout value for receiving announce
messages.

Allow Primary Leader

Select the Allow Leader check-box to set the codec as a PTP Leader clock across an AES67
AolP network.

Priority 1 and 2

Priority 1 and Priority 2 configure the user-assigned priority, ranging from 0-255, given to each
PTP clock. The default setting is 255 which is appropriate for the codec as a PTP follower and this
can be adjusted as required.

© Tieline Research Pty. Ltd. 2024
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Sync Interval

The Sync Interval sets the mean interval to send synchronization messages across the AolP

network.

PTP status

The PTP clocking status is displayed in the Synchronization panel.

Steps removed
Offset from Leader
Mean Path Delay

Codec Time

Port ID
Port Number

Port State

Priority 1
Priority 2
Clock ID

Clock Class
Clock Accuracy
Parent Port ID

Parent Port Number

Synchronization

PTP Status
1
-5086 ns
6896 ns
Oct 4, 2022, 13:52:31 GMT+8
Oct 4, 2022, 05:52:31 UTC
70-B3-D5-FF-FE-20-FF-F3
1
Locked (Follower)
Primary Leader Info
127
127
EC-46-70-FF-FE-0A-A9-28
248
39
EC-46-70-FF-FE-OA-A9-28

1

PTP Offset from Leader

15 ps F15ps
10 ps+ F10ps
5 s -6ps
04 -0
-5 s+ -5 s
-10 ps T T : : T -10 ps
15137 PM 1:51:49PM 1:5201PM 15213 PM 1:52:25 PM
PTP Mean Path Delay
Mus: :‘Mus
12 ps+ 12 ps
10 ps o =10 ps
8 uso ~8ps

T T T T T
1:51:37 PM 1:51:49 PM 1:52:01 PM 1:52:13PM 1:52:25 PM

If a Livewire Clock is in use then status is displayed in the Livewire Clock Status pane.

Livewire Clock Settings and Status

When streaming using Livewire+ the codec can be synced to a PTP clock or a Livewire device
acting as the clock leader. Livewire systems can automatically change to a different clock leader if
the current leader clock is disconnected or otherwise inoperable. This can be managed using the
Leader Priority setting. Livewire Clock Settings are displayed for a follower codec.

© Tieline Research Pty. Ltd. 2024
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Livewire Clock Settings
Leader Priority 0 (Follower Clock)
Sync To PTP
(D) Enable VLAN Tagging
VLAN Priority 0

QoS DSCP 0 Best Effort

Leader Priority

With Livewire each node has a clock leader configuration setting ranging from 0 to 7. Livewire
clock Leader Priority 3 is the default suggested for a typical Livewire network. When a higher
priority number is given to a node this will define which device becomes the network clock leader.
A value of 7 insists a device becomes the clock leader. In summary:

¢ ‘0’ means never a leader - follower only

e ‘7" means always - forced leader (note, do not use multiple forced leaders in a system)

o Factory default is 3. So all units have equal priority out of the box, and the following is used
to break ties (in descending order): lowest Livewire+ audio transmit base channel, then
lowest IP address, then lowest Ethernet address.

Livewire Clock Settings

Leader Priority 0 (Follower Clock) %

0 (Follower Clock)
Sync To PTP 9

2
(D Enable VLAN Tagging

4 (Secondary Leader Clock)
VLAN Priority 5 (Primary Leader Clock)

6

QoS DSCP 7 (Always Leader Clock)

Ca ! cel

If no clock is present then devices negotiate a clock leader using Leader Priority settings and the
lowest MAC address.

Sync to PTP

Sync to PTP is usually selected if your network uses PTP for synchronization. All devices should
enable this setting if PTP is in use, unless the Leader Priority setting is 0. When Sync to PTP is
configured in Livewire Clock Settings it synchronizes the Livewire clock to the PTP clock when
the codec is the Livewire clock master.

Enable VLAN Tagging

Select Enable VLAN Tagging to configure VLAN tagging for packet prioritization across the
network.

© Tieline Research Pty. Ltd. 2024
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1.4

VLAN Priority

The recommended setting for AES67 is to set the VLAN Priority level at 6. Note: When operating
in AVB networks the recommended setting is 5.

QoS DSCP

The QoS DSCP field in an IP packet header allows the network to easily recognize packets that
need to be treated preferentially when traversing IP networks. AF41 (34) is the default setting and
recommended for AES67. EF (46) is used for expedited forwarding of PTP clock packets.

Livewire Clock Status

Livewire Clock Status is displayed for leader and follower codecs when Livewire is in use.

Livewire Clock Status

Sync Status Locked (Follower)
Received Hardware Id 1234
Received Priority 0

Received MacAddress  70:b3:d5:20:ff:fb

When Livewire is not in use the Livewire Clock Status panel displays as follows.

Livewire Clock Status
Livewire service must be enabled and Clock Source set to
“Livewire" to enable Livewire clock synchronization.

Discovery, Advertisement and Control

Stream Discovery and Advertisement

Only stream content parameters are specified in the AES67 standard and nothing is mandated
regarding discovery and control. WheatNet-IP, Livewire and Dante use their own proprietary
protocols for discovery and advertisement. RAVENNA is an open technology which also provides
discovery and advertisement. Unless devices from vendors use or support the same stream
discovery mechanism, e.g. Tieline WheatNet-IP codecs and Wheatstone WheatNet-IP equipment,
it is necessary to configure streams manually using AES67. Therefore, to stream between the
codec and other devices using AES67 it is necessary to configure the codec to send and receive
streams using preset Source and Destination parameters.

WheatNet-IP Discovery and Control

Codecs with an optional WheatNet-IP card installed are capable of integrating with Wheatstone's
WheatNet-IP Environment. This mean they can take advantage of proprietary WheatNet-IP
discovery and control mechanisms. For example, Tieline WheatNet-IP enabled codecs support
WheatNet-IP logic I/0Os. The WheatNet-IP discovery protocol operates over a system-wide
dedicated IP multicast "announce channel”. Each device on a WheatNet-IP AolP network, having
subscribed to the multicast group, can hear the announcements of all other devices.

© Tieline Research Pty. Ltd. 2024
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Livewire+

The Axia Livewire+ discovery protocol is natively supported and codec Sources and Destinations
can be configured for use over Axia Livewire+ AolP networks. Livewire+ operates over a system-
wide dedicated multicast channel. Every device within the delivery scope for these multicasts, and
having subscribed to the multicast group, can hear the announcements of all other devices. All
devices periodically generate short presence announcements, and at longer interval, description
advertisements. The description advertisements include attributes of the device, as well as a list
and attributes of the streams they are able to transmit. Announcement data allows each participant
to build a list of the other participants and streams available on the network, to assist with
connection management. Livewire GPIOs are also supported.

SAP (Session Announcement Protocol)

SAP can be used to distribute SDP descriptions to multicast receivers, enabling simplified
connection management for multicast streaming. Tieline uses SAP version 2 as defined in RFC
2974 for multicast AolP streaming. SAP is used by Dante AolP systems for audio stream
discovery. When Tieline codec AES67 Sources are configured with SAP enabled they are
discovered automatically in Dante Controller. This facilitates simple routing of Source audio
streams within Dante systems. SAP Discovery can also be enabled in a Tieline codec to find and
configure Tieline Destinations.

© Tieline Research Pty. Ltd. 2024
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NMOS

NMOS stands for Networked Media Open Specifications and delivers Discovery, Registration and
Control for the SMPTE ST 2110 suite of standards. Discovery and Registration ensure that parts
of a networked media system can find each other. NMOS also provides connection management
and audio channel mapping to device I/O channels. This is required because essential components
for controlling and managing network devices are not included in the SMPTE standards. NMOS
delivers specifications in the form of APIs. In an NMOS system each node exposes one or more
NMOS APIs in order to find, register and control resources on each node. The codec uses TCP
port 8081 by default for NMOS communications.

RAVENNA

RAVENNA is an open technology that is AES67 and SMPTE ST 2110 compliant and it is used in
many broadcast studios around the world. RAVENNA uses Bonjour for discovery and devices from
different vendors that are compliant with RAVENNA can easily interoperate over AolP networks.

Enabling Discovery and Advertisement Services

The codec supports Livewire, SAP, NMOS and RAVENNA for discovery and advertisement of
AolP streams.

Configure Livewire Compatible Settings in Tieline Sources

Select the Enable check-box to enable Livewire Compatible streaming, which fixes some
parameters to values compatible with Livewire Sources. The Stream Mode can be adjusted
independently.

© Tieline Research Pty. Ltd. 2024
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Configure Livewire Compatible Settings in Tieline Destinations

Select the Enable check-box to enable Livewire Compatible streaming, which fixes some
parameters to values compatible with Livewire Destinations. Stream Type can be adjusted
independently.

Enabling SAP Advertisement in Tieline Sources

Select the SAP check-box when creating a Tieline Source to enable SAP and allow other devices
to easily discover a Source stream. SAP broadcasts from Sources are configured individually in
each stream.

© Tieline Research Pty. Ltd. 2024
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Enabling SAP Discovery for Tieline Destinations

Select Enable Discovery in the Services panel in the HTML5 Toolbox Web-GUI or AolP Web-
GUI to receive Destination audio streams from devices supporting SAP. Note: This setting only
affects SAP discovery in Tieline codec Destinations.

SAP Settings

Status Running

Enable Discovery |

Enabling NMOS and RAVENNA

To allow use of NMOS and RAVENNA these services need to be enabled in the Services panel in
the HTML5 Toolbox Web-GUI or AolP Web-GUI.

NMOS Settings

Status Running
(D Enabled v
Current Registry

Fallback Registration

Address

Fallback Registry Port 3210

Disable Registry Discovery

RAVENNA Settings

Status Running
Enabled i
Append Hostname ./

RTSP Port 554

Services panel in the AES67 Web-GUI

If Disable Registry Discovery is not selected, the codec will try to discover a registry
automatically using mDNS and it will be displayed as the Current Registry. If Disable Registry
Discovery is selected, the codec will use the Fallback Registration (IP) Address to specify the
registry manually. This may be necessary if more than one registry is present across a network.

© Tieline Research Pty. Ltd. 2024
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After enabling NMOS in the Services panel, it is also necessary to select the check-boxes for
NMOS in the Destination panel and Sources panel in the HTML5 Toolbox Web-GUI or AolP
Web-GUI for these streams to be discoverable.

AolP Web-GUI Sources panel AolP Web-GUI Destinations
displays NMOS enabled panel with NMOS enabled

After enabling RAVENNA in the Services panel, it is also necessary to select the check-box for
RAVENNA in the Sources panel in the HTML5 Toolbox Web-GUI or AolP Web-GUI for each
stream to be advertised.

AolP Web-GUI Sources panel
displays RAVENNA enabled

For more information about using RAVENNA for discovery and control see RAVENNA Streaming.

© Tieline Research Pty. Ltd. 2024
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14.1 NMOS Stream Management

Gateway and other Tieline G6 codecs are Networked Media Open Specifications (NMOS)
compliant and support NMOS [S-04 and 1S-05 for discovery, registration and connection
management. NMOS discovery and registration ensures that different elements of a networked
media system can find each other easily using a common software management tool.

An NMOS server in a codec can integrate with software tools such as Riedel NMOS Explorer,
which can discover, manage and connect IP Media Devices following AMWA 1S-04 and |S-05.
Some of the options that NMOS offers and that are currently supported include:

1. Discovery of nodes, devices and streams.

2. The ability to view and configure stream parameters - including displaying and copying
SDP.

3. Starting and stopping streams.

Important Notes:

TCP port 8081 is used for NMOS communications by default.

Codecs do not currently support managing redundant streams using NMOS.

Append the NMOS TCP port number to the IP address of a codec to confirm the NMOS
server is running in the codec, e.g. http://192.168.87.179:8081

mMDNS is used along with NMOS for device discovery.

Using NMOS to Manage Codec Streams
To use NMOS features it is necessary to:

1. Enable NMOS in the Services panel in the HTML5 Toolbox Web-GUI or AolP Web-GUI.

See Discovery, Advertisement and Control for more info.
2. Select the Enable Discovery check-box for individual streams in the Sources panel and

Destinations panel.

This allows codecs and streams to be discovered and managed in software tools like Riedel
NMOS Explorer.

Riedel NMOS Explorer displaying available codecs and streams

© Tieline Research Pty. Ltd. 2024
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It is simple to view and manage stream parameters, connect and disconnect streams, or copy
SDP.

Senders

Tieline SRC 03 - 206
Source: Tieline SRC 03 - 206

Tieline SRC 04 - 206 nnMgmt in B

Source: Tieline SRC 04 - 206
ource: Tieline £ ed Transportparameters

Tietine src 05 - 206 | NNANNNSINEIONRRN

Source: ne SRC 05 - 206 Start Sender

Stop Sender

1.5 Codec AES67/ST2110-30 Setup

How to Configure AolP Settings in Tieline Codecs

There are two ways to configure AolP Sources and Destinations: Tieline's HTML5 Toolbox Web-
GUI, or the AolP Web-GUI.

1. Tieline's browser-based AolP Web-GUI configuration tool configures codec AolP streams
when a computer is connected to an AES67 LAN. The AolP Web-GUI has a several
screens that allow:

Configuration of source and destination audio streams.
Monitoring and configuration of Synchronization settings.
Monitoring and configuration of Host Network settings.
Viewing Destination Statistics.

GPIO monitoring and configuration.

To access the AolP Web-GUI type the IP address of the AolP port interface into a browser, or
type the codec hostname using the following format: http://TLR6200-61086-AOIP. Hostname and
IP address details can be found in the codec via the AolP Host Network panel accessed via the
HTMLS5 Toolbox Web-GUI AolP menu. Alternatively, from the codec Home screen select Settings
> Unit Details > AolP1/2 to view the AolP network IP address.

The AolP Web-GUI looks a bit different to the HTML5 Toolbox Web-GUI but the functionality in the
available AolP panels is the same.
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2.

Gateway-16 AolP Web-GUI for Configuring Sources and Destinations

The easiest way to configure settings remotely when away from the studio is with the
Toolbox HTML5 Web-GUI connected to a codec via a WAN/LAN connection. All AolP
settings can be configured in the panels available within the AolP menu at the top of the
Web-GUI screen. The Audio Options panel can also be used to configure digital I/O
settings, like selecting AES3 or AolP as codec inputs or outputs. The Cloud Codec
Controller can also be used to configure and monitor connections and audio streams.

Important Note: The AolP Web-GUI displays all the panel settings available within the
AolP menu in the Toolbox HTML5 Web-GUI.

Configure AolP Host Network Settings

To discover the IP address of an AES67 host network using the codec front panel:

1.

2.
3.

Press the SETTINGS button.

Use the navigation buttons to select Unit Details and press the button.
IP address details are displayed under the LAN address details and the address can be
used to launch the AolP Web-GUI.

It's simple to configure host network settings using the AolP Host Network panel which is
accessed from the HTML5 Toolbox Web-GUI AolP menu.

1.

Click Edit to adjust the Hosthname or IP Mode and IP address details etc.
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2. Click Save to store new settings.

Configuring Codec Inputs and Outputs for AolP Streaming

Some global AolP-related settings reside in the Audio Options panel in the HTML5 Toolbox web-
GUI. These include:

1. Audio over IP Mode (Note: this setting is only visible if a codec has WheatNet-IP card or
Dante card (future release) installed):
¢ Native AolP Protocols (AES67, ST2110-30, Livewire+, RAVENNA), or
e WheatNet-IP, or.
e Dante.
2. Digital Input Type: AES3 or Audio over IP (AES67, ST 2110-30, Livewire+, RAVENNA,
WheatNet-IP and Dante).
3. Digital Output Type: AES3 or Audio over IP (AES67, ST 2110-30, Livewire+, RAVENNA,
WheatNet-IP and Dante).

To adjust these settings:

1. Open the HTML5 Toolbox Web-GUI and click Audio at the top of the screen, then click
Audio Options to display the Audio Options panel.

2. Click Edit to adjust settings.

3. Click Save to save settings.

Audio Options x
© Audio over IP Mode Native AolP Protocols v
Digital Input Type Audio over IP v
Digital Output Type Audio over IP v
AES Output Clock Lock to AolP Clock Source v
PPM Mode Decoder ~
Analog Input PPM Units dBFS v
Reference Level Auto v

Edit
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Important Notes:

e AES3 audio will be output and also AES67 regardless of the Digital Output Type
setting. However, there is an important point to note. When both the Digital Input Type
and Digital Output Type on the codec is set to AES3, the AES Output Clock can be
changed. However, when either the Digital Input Type or Digital Output Type is set to
AolP, the AES Output Clock is locked to the AolP clock (i.e. PTP in AES67, WNIP clock
in WNIP mode etc). Since the AES Output Clock also sets the synchronization of the
AES67 sources, it is important that the AolP clock is selected when using AES67
output. If it is not set to use the AolP Clock, then the AES67 output will usually appear
to be ok initially, but the timestamps will eventually deviate from the master clock
reference (e.g. PTP) and some devices may stop receiving the streams when the
timestamp deviates too far. So, when using AES67 outputs, it's always best to set the
Digital Output Type to AolP. If AES3 outputs are also being used, then the AES3 output
sampling clock will be locked to the AolP reference clock.

e When a Gateway codec is configured for WheatNet-IP the Tieline AolP Web-GUI in the
codec is inactive because the device AolP interface is controlled by Wheatstone's
Navigator software.

Audio over IP Mode

If an optional WheatNet-IP card is supported and installed in the codec select WheatNet-IP as
the AolP mode for used by the codec. This mode supports connecting to WheatNet-IP LANs
and allows codec stream configuration using Navigator software. If an optional Dante card is
supported and installed in the codec select Dante as the AolP mode used by the codec. Then
use Dante Controller software for stream configuration.

Select Native AolP Protocols as the AolP mode when connecting with natively supported
AES67, ST2110-30, Livewire+ and RAVENNA protocols.

Digital Input Type

Select either AES3 or Audio over IP as the Digital Input Type for the codec. This setting is
global for all digital inputs.

Important Note: PPMs on the AolP Destinations panel are inactive if the Digital Input
Type is not set to Audio over IP and the corresponding input Type is not set as Digital.

Digital Output Type

Select either AES3 or Audio over IP as the Digital Output Type for the codec. This setting is
global for all digital outputs.

Sources and Destinations

Sources and destinations identify outgoing and incoming AolP streams and are configured
separately. When configuring streams, a codec 'source' is an endpoint from which a stream is sent
by the codec to an AolP network, and a 'destination’ is an endpoint at which a stream is received
from an AolP network by the codec.
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One way to remember this is to think of the codec as an 'edge' device, bridging the divide between
WANSs like the internet, and a studio AolP network. Most devices are configured with a studio-
centric approach, so streams sent to the codec from the studio AolP network, e.g. a WheatNet
AolP network, route audio to codec destinations. Therefore the codec receives audio as a
‘destination’ from the studio's perspective. Accordingly, the studio receives audio from the codec
as an AolP network 'source'.

Product
Gateway 4

Feature

Sources and
Destinations

Notification
Configure up to 4 mono, or 2 stereo, or 1 x 8 channel (with up to
4 active channels) Source/Destination stream.

Gateway
8/16

Sources and
Destinations

Configure up to 16 mono, or 8 stereo, or 2 x 8 channel AES67
Source/Destination streams in a Gateway 16; configure up to 8
mono, or 4 stereo, or 1 x 8 channel Source/Destination stream in
the Gateway 8 codec.

MPX |

Sources and
Destinations

Configure two mono Source/Destination streams, or a single
stereo Source/Destination stream.

MPX 1l

Sources and
Destinations

Configure up to 4 mono or 2 stereo Source/Destination streams.

Bridge-IT I
and Bridge-
IT XTRA Il

Sources and
Destinations

Configure two mono Source/Destination streams, or a single
stereo Source/Destination stream.

Source Configuration Settings

Configurable Source settings for audio streams sent by the Tieline codec over the AES67 LAN
are listed in the following table.

Sources (Tieline — Device)

Status Idle

Name Tieline SRC 09
Address 239.192.01
Channel 1
UDP Port 5004
Interface AclP Port 1
Frame Size 250 microseconds
Codec Type 124
Maode 2 Channe!
Type Mono
@ Upmix Enable
Enable Discovery SAP NMOS RAVENNA
Livewire Compatible Enable o

Stream Mode | Custom v
Hide Advanced Settings
Time to Live (TTL) 0
QoS DSCP 0 Best Effort v
VLAN Priority Disabled
Payload Type a6

AolP Port
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Parameter Settings

Name Source stream name for identification purposes only; no effect on
stream.

Address Multicast IP address details; the default address for 16 source streams
is 239.33.1.0 to 239.33.1.15.

UDP Port The default UDP streaming port for RTP packets is usually 5004

Interface Select the primary AolP interface to use for the source stream.

Frame Size Various settings from 125 microseconds to 4 milliseconds

Codec Type Choose from L16 (16 bit) or L24 (24 bit) sampling; note the sampling
frequency is configured in the Synchronization panel and is usually 48
kHz. All streams us a common sampling rate.

Mode Select from 2 channel or 8 channel streaming in streams 1 and 9; this
setting is not available for other streams and 2 channel is the defaullt.
Note: streams become unavailable when 8 Channel mode is selected,
based on how many channels out of 8 are selected. Note: The number
of channels available depends on the model of codec purchased and
channel licenses installed. Between 8 and 16 channels may be
available.

Type Configure mono or stereo streams; 3 - 8 channels also available for
streams 1 and 9.

Upmix Select the Enable check-box to duplicate a mono channel for a stereo

stream.

Enable Discovery

Select a discovery protocol for simplified stream connection
management, e.g. SAP, NMOS and/or RAVENNA. Note: No SAP
announcements are sent if PTP is not locked.

Livewire Compatible

Select the Enable check-box to fix several parameters to values
compatible with Livewire Sources.

Stream Mode

Select the preferred Livewire+ Stream Mode to suit the type of Source
being configured.

Time To Live (TTL)

Setting used in multicast routers to ensure data packets have a finite
life and don't cause congestion over networks. Each time a packet
passes through a router it reduces by 1 until it reaches zero, at which
point a router will no longer pass the packet.

QoS DSCP

Quality of Service setting using the DiffServ method as described in
RFC 2474. Uses the DSCP field to mark packets according to their
packet class. 34 is the default setting and recommended for AES67.
46 is used for expedited forwarding.

[ VLAN Priority

| Represents a QoS prioritization scheme for Ethernet frames.

Payload Type

Some equipment requires a payload setting and the Tieline default
setting is 96

Add Redundant
Stream

Add a redundant IP stream and transmit an identical IP packet stream
over a different AolP interface. Packets are seamlessly reconstructed
by the receiver to ensure flawless audio is received.
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Destination Configuration Settings

Configurable Destination settings for audio streams received by the codec over the AES67
LAN are listed in the following table.

Parameter Settings
Name Destination stream name
Address Multicast IP address details; the default address for 16 destination

streams is 239.46.1.0 to 239.46.1.15. Note: The default destination
multicast address will normally be configured by the device streaming
audio to the Tieline codec. Verify this address with the network IT
administrator and then place the correct address into the Address text
box in the Destinations panel. Note: The codec can receive a stream
on multiple Destinations using the same multicast IP address.
Configuration settings that need to be the same include the destination
address, UDP port, AolP Port, source filter and Type. Other settings
are automatically configured as per the initial Destination stream

configured.
Channel The unique channel number used by Livewire to identify streams. Note:
Only displayed for Livewire streams.
| UDP Port | The default UDP streaming port for RTP packets is usually 5004
| Interface | Select the primary AolP interface to use for the destination stream.
Codec Type Choose either L16 (16 bit) or L24 (24 bit) samples. All streams us a

common sampling rate.

Mode Select from 2 channel or 8 channel streaming in streams 1 and 9; this
setting is not available for other streams and 2 channel is the default.
Note: streams become unavailable when 8 Channel mode is selected,
based on how many channels out of 8 are selected.

Type Configure mono or stereo streams; 3 to 8 channels also available for
streams 1 and 9.

Downmix By default -6dB of gain reduction is applied to the left and right
channels of the received 2 channel stereo stream and downmixes audio
into mono; selectable configuration options include Left + Right, Left
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only, or Right only. Note: When configuring a mono Destination
stream, if a stereo RAVENNA, SAP or Livewire stream is parsed, then
Downmix will be automatically selected for compatibility. RAVENNA
and SAP include SDP info on the number of channels in a stream.

Enable Discovery

Select the check-box to enable NMOS
configuration/control of a Destination audio stream.

discovery and

Livewire Compatible

Select the check-box to Enable Livewire+ compatibility in the codec.
This feature fixes some parameters to values compatible with Livewire
Destinations. The Livewire tab in the Destinations panel displays all
advertised Livewire+ Sources across the network.

Type

The Livewire Compatible stream Type is typically configured when a
Livewire stream is parsed using the Livewire tab. It can also be
manually configured using the Type drop-down menu. Options define
elements like whether a specific Livewire IP address range is
configured, or a custom stream configuration can also be defined.

Syntonous

Syntonous receive mode is used by default in Livewire Destinations and
is supported by some other vendors. In Syntonous mode the sampling
frequency is locked, but the absolute time reference at the sender and
receiver may be different. Redundant streaming is not supported in this
mode.

Buffer Depth

When operating in Syntonous mode, the storage buffer used to capture
incoming data packets ensures the continuity of audio streams by
smoothing out packet arrival times during periods of network
congestion.

Link Offset

The Link Offset is defined as the difference in time between when the
audio enters the transmitter and exits the receiver. The link delay
setting must be greater than the worst case link delay, taking into
account network jitter. This setting is not available in Syntonous mode.

Source Filter Enable
(Advanced Settings)

Select the check-box to enable and disable Source filtering.

Source Filter | Only accept data from the origin address that is pushing to the
Address multicast address. Leave empty to accept any source address.
(Advanced Settings)

ST 2110-30 | Select the Enable check-box to configure the Media Clock Offset
Compatibility setting as 0. This is required for ST2110-30 compliant streaming.

Media Clock Offset

Configurable Media Clock Offset setting. Note: when ST 2110-30
Compatibility is enabled this setting is greyed out and set to 0.

Add Redundant
Stream

Add a redundant IP stream and stream an identical IP packet stream
over a different AolP interface. Packets are seamlessly reconstructed
by the receiver to ensure flawless audio is received.

HTTP Nodes

RAVENNA allows advertisement of web management interfaces
controlling devices to which you are connecting. The HTTP Nodes tab
displays Hosthame and Address links to launch a device management
interface directly.

Livewire

Displays available Livewire+ Sources. When a Source is selected, the
SDP is fetched, parsed and populated in the fields within the
Destinations panel.

Manual SDP

Copy and paste SDP text from an AES67 compatible device and click
the Parse SDP button to configure a destination stream. This will
configure the codec to receive an audio stream from a device.
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RAVENNA tab Displays available RAVENNA Sources. When a Source is selected, the
SDP is fetched, parsed and populated in the fields within the
Destinations panel.

RAVENNA URL tab Copy a known RTSP URL address for a device and then paste into the
RAVENNA URL tab to populate data in the Destinations panel.

SAP tab Displays sources advertised using SAP. When a Source is selected,
the SDP is fetched (and can be viewed), then it can be parsed and
populated in the fields within the Destinations panel.

Use the following sections to configure Source and Destination streams for the various proprietary
AolP systems.
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1.6

Configuring AES67 Sources and Destinations

Product
Gateway 4

Feature

Sources and
Destinations

Notification
Configure up to 4 mono, or 2 stereo, or 1 x 8 channel (with up to
4 active channels) Source/Destination streams.

Gateway
8/16

Sources and
Destinations

Configure up to 16 mono, or 8 stereo, or 2 x 8 channel AES67
Source/Destination streams in a Gateway 16; configure up to 8
mono, or 4 stereo, or 1 x 8 channel Source/Destination stream in
the Gateway 8 codec.

MPX |

Sources and
Destinations

Configure two mono Source/Destination streams, or a single
stereo _Source/Destination stream.

MPX 11

Sources and
Destinations

Configure up to 4 mono or 2 stereo Source/Destination streams.

Bridge-IT 1l
and Bridge-IT
XTRA 11

Sources and
Destinations

Configure two mono Source/Destination streams, or a single
stereo Source/Destination stream.

More information about individual settings in this section are available in the AES67 Setup section
within this manual.

Creating an AES67 Source (Outgoing audio stream from Tieline codec)

1. To create an outgoing Source stream open the Tieline AolP Web-GUI. Note: if you don't know
the IP address of the codec on the AES67 LAN, open Toolbox HTML5 Web-GUI for the codec
and then open the AolP Host Network panel in the AolP menu to view the address.

2. In the AolP Web-GUI select Sources (or in the HTML5 Toolbox Web-GUI click AolP and then
Sources to open the Sources panel).

3. Choose a stream to configure and select the Configuration symbol ﬁ’}, then click Edit. Note:
Matrix Editor hard coded Source output channel assignments for streams depend on the
stream configuration mode. This is outlined in the table that follows later in this section.
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© N
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Edit the Name of the stream if required. Note: this is for identification purposes only and has no
effect on the stream.

The multicast Address is entered into the AolP device that will receive a client multicast stream
and the UDP Port should also be configured correctly. Note: use the default destination
address or edit as appropriate. Take care to not use one of the reserved addresses (see
https://en.wikipedia.org/wiki/Multicast_address).

Select the preferred primary AolP Interface used to stream audio.

Select the Frame Size (packet time) from 125 microseconds to 4 milliseconds.

Configure the Codec Type. In most situations this will be L24 (24 bit).

Streams 1 and 9 can be configured in either 2 Channel or 8 Channel Mode. This mode needs
to be configured in both devices for streaming to succeed. Streams become unavailable when 8
Channel mode is selected, based on how many channels out of 8 are selected. Note: The
number of channels available depends on the model of codec purchased and channel licenses
installed.

10. Configure the Type of connection. For most connections this will be mono or stereo; streams 1

and 9 can also be configured to stream between 1 and 8 channels of audio. Up to 8 PPMs are
displayed for a single stream with up to 8 channels of audio.

11.Click Save to save all configured settings.
12.Verify audio is metering on the PPMs and click the Start symbol D> to start streaming.

Running appears in green when streams are successfully streaming.

Gateway codec Sources panel

Redundant Streaming

SMPTE ST 2022-7 compliant redundant streaming (Seamless Protection Switching) can be
configured for a Source or Destination stream. When configured, the codec transmits two packet
streams, one on each interface, containing identical copies of the payload in each packet. This
allows hitless merge, whereby a single reconstructed output stream is created through seamless
protection switching at the RTP datagram level. For each stream it is possible to select whether
port AolP 1 or AolP 2 will be used to transmit or receive packets.

Important Notes:
o Two different AolP interfaces must be configured for redundant streaming. AolP 1 is
the default interface for the primary stream.
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e While both AolP ports can be connected to the same switch and use the same

subnet, it is recommended that they are connected to separate switches on
separate subnets for network resilience.

e When a Source employs redundant streaming using the same multicast address then

each AolP interface must be configured with a different subnet. E.g. 192.168.87.x
and 192.168.88.x.

If both AolP ports are on the same subnet then each redundant source stream leg
must use a different Destination multicast address.

Multiple PTP Leaders are required to configure redundancy. We recommend using
at least two Primary Leader PTP clocks. When configuring PTP in a SMPTE
ST2022-7 redundant network setup, each Primary Leader should be connected to
both networks in order to avoid different synchronization times in the two networks.
E.g. In case only one clock loses its GPS reference signal. PTP Primary Leader
synchronization on each interface must have very closely aligned clocks, otherwise
glitches may occur when failing over from one Primary Leader to the other. For
example, in the case of a link failure, if a PTP Leader fails over to a redundant PTP
Leader clock, PTP sync will be lost momentarily until it locks to the redundant
Leader clock. The AolP Port Number change will be displayed in the
Synchronization panel.

e DO NOT engage loopback of AES67/ST2022-7 Source and Destination streams on

the same codec as this is not supported.

Configuring Tieline Source Redundant Streaming

1.

In the AolP Web-GUI select Sources.

2. Select Add Redundant Stream.

3.

Insert the multicast address and adjust the redundant streaming Interface if required.
Please note: the same multicast address can be used for the primary and redundant
streams when each leg is on a different subnet.
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Redundant Stream (Delete)
Address 239.33.144.0

Interface AolP Port 2

Cancel Save

Rl P e T

L T

4. Click Save to store the new settings.

Matrix Editor Source Output Assignments

When streaming in AES67 mode, the Matrix Editor hard coded output channel assignments
depend on the stream configuration Mode. Verify audio is displayed on the PPMs in the Sources
panel before commencing streaming.

AolP Audio Stream Mode Mix Outputs Used
Source 1 Mono 1
Stereo 1land 2
8 Channel 1t08
Source 2 Mono 2
Source 3 Mono 3
Stereo 3and 4
Source 4 Mono 4
Source 5 Mono 5
Stereo 5and 6
Source 6 Mono 6
Source 7 Mono 7
Stereo 7 and 8
Source 8 Mono 8
Source 9 Mono 9
Stereo 9 and 10
8 Channel 9-16
Source 10 Mono 10
Source 11 Mono 11
Stereo 11 and 12
Source 12 Mono 12
Source 13 Mono 13
Stereo 13 and 14
Source 14 Mono 14
Source 15 Mono 15
Stereo 15 and 16
Source 16 Mono 16

Source SDP File Download

SDP is a format for describing RTP sessions and operating parameters, including network
addressing, encoding format and other metadata. When configuring Destination streams on other
devices, it is possible to download an SDP file for each Tieline codec AES67 audio stream and
copy the text file contents into other devices to configure the stream on that device. To copy Tieline
codec Source stream information onto other devices supporting this feature:
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1. Choose a stream to configure and select the Configuration symbol @, then click
Download SDP.

Action Index “ Name

e ine SRC 02
Download SDP p

o) ine sRC off

¢
o Force Stop ine SRC 04

ﬁ > s Jicline SRC 0’

2. Save the file on a computer and using a text file editor copy the text from within the file and
paste it into the Destination stream on the other device supporting this feature. Note: not all
devices support this feature.

Download all Source SDP Files and Select Columns to Display

To download all Source SDP files simultaneously select the Configuration symbol & at the top
of the screen and click Download all SDPs. Note: It may be necessary to "allow" the download of
multiple files in your browser.

Helpful Tip:

Select the Configuration symbol ¥ at the top of the screen and click Start all streams

or Stop all streams to simultaneously control all Sources. Click to select and deselect
Columns to show / hide columns in the panel.
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Important Notes:

Two different AolP interfaces must be configured for redundant streaming. AolP 1 is
the default interface for the primary stream.

While both AolP ports can be connected to the same switch and use the same
subnet, it is recommended that they are connected to separate switches on
separate subnets for network resilience.

When a Source employs redundant streaming using the same multicast address then
each AolP interface must be configured with a different subnet. E.g. 192.168.87.x
and 192.168.88.x.

If both AolP ports are on the same subnet then each redundant source stream leg
must use a different Destination multicast address.

Multiple PTP Leaders are required to configure redundancy. We recommend using
at least two Primary Leader PTP clocks. When configuring PTP in a SMPTE
ST2022-7 redundant network setup, each Primary Leader should be connected to
both networks in order to avoid different synchronization times in the two networks.
E.g. In case only one clock loses its GPS reference signal. PTP Primary Leader
synchronization on each interface must have very closely aligned clocks, otherwise
glitches may occur when failing over from one Primary Leader to the other. For
example, in the case of a link failure, if a PTP Leader fails over to a redundant PTP
Leader clock, PTP sync will be lost momentarily until it locks to the redundant
Leader clock. The AolP Port Number change will be displayed in the
Synchronization panel.

DO NOT engage loopback of AES67/ST2022-7 Source and Destination streams on
the same codec as this is not supported.

Creating an AES67 Destination (Incoming audio stream to Tieline codec)

1. To create an incoming Destination stream it is necessary to find out the multicast address and
port used by the device sending the stream to the codec over the AES67 LAN.

Example of LAWO device displaying its Multicast Source IP address and port

2. This information can be used to create a Destination audio stream in the codec as follows.
Note: Matrix Editor input channel assignments for Destination streams depend on the stream
configuration Mode. This is outlined in the table that follows later in this section.
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3. Click Save to save all configured settings.

4. Click the Start symbol > to commence streaming. Running appears in green when
successfully streaming and incoming audio should appear on the PPMs.

Configuring Destination Redundant Streaming

SMPTE ST 2022-7 compliant redundant streaming can be configured for an incoming destination
stream.

1. Inthe AolP Web-GUI select Destinations.
2. Select Add Redundant Stream.

@ Link Offset 10 ms | = | 480 samples | §

Show Advanced 5Settings

Add Redundant Strea@

e As s ds

5. Insert the multicast address and adjust the redundant streaming Interface if required.

Please note: the same multicast address can be used for the primary and redundant
streams.
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6. Click Save to store the new settings.

Important Note:

e The destination Link Offset for redundant streams must be configured for the leg
which has the highest link latencyi/jitter.

e The Link Offset includes link delay and receiver jitter buffer delay. To calculate the
Link Offset setting determine network delay, including time in transmitter jitter
buffers, and then add receiver jitter buffer latency. Ensure the Link Offset is higher
than the total of network and jitter latencies.

Matrix Editor Destination Input Assignments

When streaming in AES67 mode, the Matrix Editor input channel assignments depend on the
stream configuration Mode as displayed in the following table.

AolP Audio Stream Mode Mix Inputs Used
Destination 1 Mono 1
Stereo 1land?2
8 Channel 1t08
Destination 2 Mono 2
Destination 3 Mono 3
Stereo 3and 4
Destination 4 Mono 4
Destination 5 Mono 5
Stereo 5and 6
Destination 6 Monho 6
Destination 7 Mono 7
Stereo 7 and 8
Destination 8 Mono 8
Destination 9 Monho 9
Stereo 9 and 10
8 Channel 9-16
Destination 10 Mono 10
Destination 11 Mono 11
Stereo 11 and 12
Destination 12 Mono 12
Destination 13 Mono 13
Stereo 13 and 14
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Destination 14 Mono 14

Destination 15 Mono 15
Stereo 15 and 16

Destination 16 Monho 16

SDP Destination File Upload, or SDP Copy and Paste Function

When configuring Destination streams on a Tieline codec it is possible to upload an SDP file, or
copy and paste the contents of an SDP text file, for each audio stream configured. To facilitate this
feature, the other device must support SDP text file creation, or copying and pasting SDP info.
Note: WheatNet-IP Blades and Telos xNodes support this feature.

Important Note: Ensure a stream is not running when uploading an SDP file or pasting SDP

data into the web-GUI or it will fail.

To upload a saved SDP text file with Destination information:

1. Select the Configuration symbol {5 on a stream and then click Upload SDP.

& o 8 & & B

{6}.».;....’*‘

2. Select a saved SDP file and upload it.

To copy and paste SDP information from a text file into a Destination:

1. Select the Configuration symbol {5 on a stream and then click Edit.
2. Copy the SDP information from the text file extracted from the other device into the text box

adjacent to the Apply SDP button.

3. Click the Apply SDP button.

4. Ensure Destination settings have been populated correctly and click Save.
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Important Note: If there is a PTP mismatch, a warning will display in the Destinations
panel stating Parsed Grandmaster clock ID does not match current Grandmaster
clock ID. This may occur when there is a change in a PTP Primary Leader and an SDP
file has been generated using info from a previous PTP clock.

To avoid this message, download a new Source SDP file and apply this SDP file in the
Destinations panel.

5. Click the Start symbol > to commence streaming. Running appears in green when
streams are successfully streaming.

Action Index;

© @j T

D

Source and Destination Status Indications

Following are the Status indications for a Source and Destination.

Source Status Displayed Source Status Description

Idle The stream is configured and not running

Running The stream is active and running

Unavailable The stream is unavailable because it is allocated to another
stream

Unlicensed The stream requires a license upgrade to be available for
streaming

Error The stream has detected an error. This will also appear when
an IP interface is removed. Stop and restart a stream to
remove this error message.
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Destination Statistics

There are two ways to monitor Destination packet and jitter statistics.

Statistics in Destinations Panel

1. Select the Configuration symbol & for a Destination, click Edit, and then Show
statistics.

Packet and jitter stats are displayed for each Destination Interface.

Important Note:

o If the Minimum displays 0 this indicates the buffer has emptied and it is
recommended that the Link Offset be increased to avoid artifacts and loss of audio.

. | 239.10.1.0 AclP Port 1 %
{@} [m] 7 Lawo srcQ Running I ]
L 239.10.253.0 AclP Port 2
Leg Packets Buffer Level
Total Late ¥ Early Minimum Maxim... Average :
1 346375698 0 0 0 152 131 '
2 342466410 0 0 0 152 131 ‘

Reset statistics

'w)www—_’*w’

e A red Caution symbol is displayed when a Destination stream issue may require
attention. Examples of when this will appear include:

o Late packets: If packets have been received late and have been lost the Link
Offset may need to be increased. If the Minimum for received packets is a
number close to zero (or zero) the Link Offset should be increased.

o Early packets: If packets arrive early and the buffer is already full packets will be
dropped. Decreasing the Link Offset may resolve this issue. Also check that the
sender and receiver are properly synchronized to the same PTP Primary Leader.

0 Zero Minimum Buffer Level: A warning is displayed if the stream is running and the
buffer has previously emptied.
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o High Maximum Buffer Level: If the Maximum latency is high, e.g. over 1000,
causes of high network latency should be investigated.

Destination Statistics Panel

1. Inthe AolP Web-GUI select Destination Statistics.

2. This provides an overview of packet and jitter statistics for all Destinations in one screen.

Reset Statistics

Click the Reset button to reset the statistics for a Destination or click Reset All to reset the
statistics for all streams in the Destinations Statistics panel. It is also possible to show, hide,
and reset Destination statistics from within the Destinations panel.

1. Inthe AolP Web-GUI select Destinations.

2. Select the Configuration symbol < at the top of the screen and click to show and hide
statistics for all Destination streams within the panel; click Reset all statistics to reset the

display.
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Helpful Tip:
Select the Configuration symbol & at the top of the screen and click Start all streams
or Stop all streams to simultaneously control all Destinations. Click to select and deselect

Columns to show / hide columns in the panel.

1.7 GPIO Panel

The GPIO panel in the AolP Web-GUI displays the current active state of logical Livewire GPIOs
in the codec. A maximum of 64 are available and displayed.

Note: Livewire must be enabled in the Services panel or the panel is disabled
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Livewire is not running.

Enable Livewire under Services to use this panel.
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1.8

WheatNet-IP Streaming

Configuring Codec WheatNet-IP Cards for Use with Navigator

Wheatstone Corporation uses the WheatNet-IP protocol to transport and manage IP streams
throughout broadcast plants. A Tieline Gateway with an optional WheatNet-IP card on-board can
interface directly and seamlessly with these systems. When a WheatNet card is installed inside the
Tieline Gateway and Gateway 4 codecs it does not require configuration using Wheatstone's
Razor setup tool like Genie and Merlin WheatNet-IP codecs. Audio stream source and destination
routing can be directly configured using WheatNet-IP Navigator software.

Important Notes:

* Navigator v3.8.798 was used in testing and configuration.

o If all blades are Blade-1 or Blade-2 blades with the green single-line display on the front
panel, then it is not possible to use PTP/AES67.

o Ensure your network switch supports full-duplex 1000BASE-T and verify the link speed
by checking that only the green WheatNet Ethernet port LED is on or flashing.

Prerequisites

1. The Tieline codec must have a WheatNet-IP card installed.

Configure the Codec for WheatNet-IP Streaming

Before streaming audio from the codec using WheatNet-IP it is necessary to configure the codec
for WheatNet-1P.

1. Open the HTML5 Toolbox Web-GUI and click Settings at the top of the screen, then click
Audio to display the Audio Options panel.

2. Click Edit to adjust settings.

3. Click the drop-down menu for Audio over IP Mode and select WheatNet-IP.

4. Both the Digital Input Type and Digital Output Type in the Audio Options panel need to
be configured for Audio over IP.
5. Click Save to save settings.

The Audio over IP Mode can also be configured using the front panel of the codec:

1. Pressthe SETTINGS button.
2. Use the navigation buttons to select Audio Options and press the button.
3. Select AolP Mode and press the button.
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4. Select WheatNet-IP and press the button.

Important Note:
¢ When the AolP Mode is changed we strongly recommend rebooting the codec using
either the Reset / Backup panel in the Toolbox Web-GUI, or by navigating to
Settings > Reset & Backup > Reboot Codec via the codec front panel.
e It is a good idea to close and relaunch Navigator if you change the Audio over IP
Mode setting from Native AolP Protocols to WheatNet-IP. Otherwise the codec
may not be initialized successfully in the following procedure.

Configure a Gateway Codec with a WheatNet Card

After attaching a Gateway or Gateway 4 codec to a WheatNet-IP network and configuring the
codec for WheatNet-IP streaming it is first necessary to configure a few settings. Note: the codec
will appear as a Blade in Navigator and can be configured like a Wheatstone Blade.

1. Launch Navigator and click to select the codec (Blade) within the System pane in the top-
left corner of Navigator, then select the Preferences tab. Click to select the Enable
Advanced Controls check-box.

2. Right-click the codec under System and select Initialize Blade. Note: if you are connecting
multiple codecs simultaneously, the MAC address can be used to identify each codec. The
MAC address displayed on codecs in the System pane in Navigator can be matched to the
WheatNet card MAC address displayed on the sticker on the chassis of each codec.

© Tieline Research Pty. Ltd. 2024



44

AolP User Manual v1.7

3. The Initialize dialog should open allowing you to rename the codec and if necessary
configure network settings. Click the Configure Blade button to save new settings.

4. Navigator may take several minutes to configure the codec into the WheatNet system.
Initially the codec may disappear from the System pane in Navigator and then reappear
after a minute or two and be renamed with the new name given to the device.
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When configuration is complete, click to select the Blade in the System pane and select the
System tab on the left and the Crosspoint tab at the top to verify all Sources and
Destinations for the newly added codec are visible and selectable.

Important Note:

e Ensure audio is routed in the codec Matrix Editor from inputs to outputs if the codec is
feeding audio into the WheatNet-IP network from codec input sources. |.e. route audio
from inputs to outputs to create a WheatNet source in this way.
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¢ In addition, if input audio is routed to outputs to create a WheatNet source, ensure the
Outputs panel sliders used to output Send/Return audio from the output are mixing
Send 100% audio to the outputs. Otherwise audio will not be outputted to the Blade
Source. By default, the outputs are configured as Return 100% without Send audio
mixed in. If Return audio is not required this can be removed from the mix.

e When the codec is configured for WheatNet-IP the Tieline AolP Web-GUI in the codec
is inactive because the device is controlled by Wheatstone's Navigator software.

Managing Available Gateway Sources and Destinations

By default, when a Gateway or Gateway 4 codec is added to Navigator as a Blade it is configured
with 16 available channels, or Signals in Navigator. If you have purchased a Gateway with fewer
than 16 channels, e.g. Gateway 8, or have purchased a Gateway 4 codec supporting 4 channels,
it may be necessary to delete the unavailable Source Signals and Destination Signals in
Navigator. This will avoid any confusion with unavailable Signals, whereby Sources and
Destinations within Navigator appear as available, even though they are not.

For example, if the codec Blade in the following image was a Gateway 8 with 8 available
channels/Signals, simply select the Sources tab in Navigator for the device and delete the 4
unavailable stereo Source Signals. Then do the same in the Destinations tab for 4 unavailable
stereo Destination Signals.
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The same principle would apply for mono Source Signals and Destination Signals in Navigator,
i.e. delete 8 the unavailable mono Source Signals and Destination Signals. If a Gateway is

upgraded to increase channel density, e.g. from 8 channels to 16, it is relatively simple in Navigator
to add Source Signals and Destination Signals as required.

Reset the WheatNet Card to Factory Defaults

To reset the WheatNet card back to factory default settings:

1. Select the Blade Admin tab and then select the Factory Reset check-box. Select Yes in
the confirmation dialog that is launched.

2. Click the Full Blade Reset button to reset the codec's WheatNet card to factory defaults.
1.8.1 Stream to WheatNet using AES67

Tieline Codecs Streaming without a WheatNet-IP Card

It is possible to configure a Tieline codec to stream audio using AES67 without a WheatNet-1P
card. For example, a Gateway codec may not have a WheatNet card installed or you may be
streaming using an MPX or Bridge-IT Il codec. Following is the configuration procedure.
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Setting Up a Blade for Receiving AES67 Audio

To configure AES67 streaming it is necessary to:

1. Ensure the Blade is licensed for AES67 streaming.
2. Add the codec as an AES67 Device in Navigator for connectivity.
3. Verify the Blade's AES67-PTP timing status.

Important Notes:

o A Blade-3 blade must be set as the system’s leader clock to use PTP/AES67, or a
separate PTP clock must be designated as the network's primary leader clock.

o If all blades are Blade-1 or Blade-2 blades with the green single-line display on the front
panel, then it is not possible to use PTP/AES67.

Ensure the Blade is Licensed for AES67 Streaming

Check that Navigator has both licenses by clicking the ? About button in navigator, then click the
Show License button to view Navigator's license.txt file, which is saved in: C:
\ProgramData\Wheatstone\Navigator\. The text for both licenses must be listed. The top one is
your Navigator license, which has the product entry line: PROD WNIPNavigator. Below that is the
PTP clock license, which has this product entry line: PROD PTPClocking.

If the PTPClocking license is not displayed, contact Wheatstone support to request an AES67-
PTP License.

Add a Tieline Codec to Navigator

The codec needs to be added to navigator as an AES67 device so the WheatNet-IP Blade can see
the codec and stream AES67 audio between the devices.

1. Select Devices and then select the AES67 Devices tab.

2. Select Add to add a new device.
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3. Enter the Name and the AES67 LAN IP Address details for the codec, then click OK.
Note: AES67 LAN IP Address details for the codec are displayed in the AolP Host
Network panel in the Toolbox HTML5 Web-GUI, or the AolP Web-GUI.

u Add AESET Device - Wheatnet-IP Mavig... X

MName:

IP Address: E]

Host Blade: | Blade02

oK Cancel

4. The codec is now added as a device in Navigator under AES67 Devices. Complete this for
multiple codecs if required.

Verify the Blade's PTP Timing Status

1. Ensure the PTP Leader Clock is running on the AES67 LAN to which the codec is
connecting.

2. Select the Blade and System and then select the Info tab.
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3. Inthe Clock Master Info section ensure the Frequency is set as 48kHz and change the
Primary External Reference to AES67-PTP. The PTP Status is green and locked when
the clock is detected.

4. The Tieline codec supports low latency AES67 audio streams down to 125 microseconds
and in testing Wheatnet Blades default to 250 microseconds, which is also supported by
Tieline. To use an AES67 device in WheatNet systems using the 1 millisecond AES67
latency setting, it will be necessary to also configure the default AES67 packet rate to 1
millisecond. To view or adjust this setting select the Blade and then select the Blade Info
tab. WheatNet-IP will successfully stream between Tieline codecs using 250 microsecond
packet timing, as well as other devices using 1 millisecond timing, using a process they call
"packet timing translation."
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Configure a Tieline AES67 Source and Stream to a Blade

Note: In testing the multicast IP address range 239.192.1.xxx was used successfully.

1. Configure a Source in the Tieline codec.

Sources (Tieline — Device)

Status Idle

Name Tieline SRC 01

Address 239.192.1.0

UDP Port 5004

Interface AolP Port 1 s
Frame Size 250 microseconds .4
Codec Type L24 s
Mode 2 Channel s
Type Stereo :
Enable discovery SAP NMQOS RAVENNA

Show Advanced Settings

Add Redundant Stream

Cancel Save

2. In Navigator select the Tieline codec under AES67 Devices and select the Sources tab.
Then click the Add button.
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3. Name the Source stream and then select the Stream Info tab.

4. Add the multicast address and port details and click OK to create the Source stream, then
click Finish.

5. The Tieline codec AES67 Source stream is now configured in Navigator.
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Sources  Destinations  Info

AES67 Source Signals

Systemn

Id Name  Location

1.4.1.1: TL-1501 | Gateway

Devices

Bladen2

AESHT - Gateway0l

6. Click the Start symbol D> to start streaming.

Sources (Tieline — Device)

Action Index = MName Status IPV4 Address Remote UD... Mode Fram...

Tieline SRC 01 Running 239.192.1.0 5004 2 Channel 250ps

30.33.1.1 5004 Ous

7. The Tieline Source stream can now be monitored and routed as required using Navigator.

Configure a Tieline AES67 Destination and Receive a WheatNet-IP Source
Stream

To configure a Blade Source signal to stream to a codec Destination it is necessary to:

1. Create an AES67 Source stream from the Blade.

2. Route it to the Tieline codec in Navigator.

3. Configure the Destination stream settings on the Tieline codec. Note: the WheatNet-IP
multicast IP addresses in testing used addresses in the range 239.192.192.xxx.
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Create an AES67 Stream from a Blade

1. Select AES67 Devices and then select the Destinations tab.

2. Click Add to open the Destination AES67 Signal Wizard and enter a name for the
Destination.

3. Select the Stream Info tab and then Edit. Most settings can be left as the default
configuration. The following settings were successfully configured and used to stream
audio. Click OK to store the stream parameters, then click Finish to close the Destination

AES67 Signal Wizard dialog.

Note: By default WheatNet-IP uses port 50100 but this can be any supported port e.g. 5004,
as long as the ports match on both devices connecting. The Tieline codec supports 250

microsecond packet timing.
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4. Select System and then the Crosspoint tab to view the newly created Tieline Destination
just created displayed at the bottom of the Destinations list. Note: WheatNet-IP sources
are not active until they are routed somewhere in Navigator.

5. Right-click the source to be sent to the Tieline codec Destination and select Show SDP.

6. Copy the SDP file info.

SDP File for WNIP Source Signal: 1.0.0.1 - Wheatnet-IP Mavigator

Ik X
0.25ms 1.00ms Copy
w=0 Save...
o=- 73107711 78107711 IN IP4 192.168.57. 102

s=wnip/s:1.0.0.1

1=BL002501 : Blade01

c=IN IP4 239,192, 192.8/255

t=00

m=audio 5004 RTF/aVF 100

a=recvonly

a=rtpmap: 100 L24/48000/2

a=ptime:0.25

a=ts-refdk:ptp=IEEE 1588-2008: 58-50-ab-ff-fe-80-08-40:0
a=mediadk:direct=0

Close

7. Copy the SDP text into the Parse SDP text box in the Tieline codec Destination panel for
a Destination, then click Parse SDP. Next click Save.

© Tieline Research Pty. Ltd. 2024




56

AolP User Manual v1.7

Destinations (Device — Tieline)

RAVENNA RAVENNA URL Manual SDP HTTP Nodes

Paste SDP into the text area below, then select parse to update the stream fields.
v=0
0=- 78107711 78107711 IN IP4 192.168.87.102
s=wnip/s:1.0.0.1
i=A1-1501 : Gateway0
c=INIP4 239.192.192.8/255
=00
m=audio 50100 RTP/AVP 100
a=recvonly
a=rtpmap:100 L24/48000/2
a=ptime:1
a=ts-refclk:ptp=IEEE1588-2008:00-00-00-00-00-00-00-00:0
a=mediaclk.direct=0

SDP parsed successfully. Settings have been applied.

8. Click the Start symbol D> to start streaming.

e @ 5 wnip/s:1.0.0.1 Idle

{§} [m} 5 wnip/s:1.0.0.1 Running = I 239.192.192.8 5004 2 Channel 250ps

AES67 Audio Streaming
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1.9 RAVENNA Streaming

RAVENNA is an AolP technology developed by ALC NetworX. It is built upon open standards and
extends AES67 and ST2110 by specifying a mechanism for stream discovery and advertisement.
RAVENNA is used in many broadcast studios around the world.

Enabling RAVENNA in the Codec
To enable the codec to use RAVENNA:

1.
2.
3.

4,
5.

Open the AolP Web-GUI and select Services to display the Services panel.

Click Edit for RAVENNA Settings to adjust panel settings.

Select the Enabled check-box and then select the Append Hostname check-box to add
the device hostname to RAVENNA Source names. Adjust the RTSP port used to pass SDP
data as required.

RAVENNA Settings

Status Off
Enabled v
Append Hostname

RTSP Port 554

cance'

Important Notes:

o Advertisement and discovery for RAVENNA streams is only available using the AolP 1
port. Streaming is available on both AolP 1 and AolP 2 ports.

o If identical Source names may exist on multiple devices, it is best to use the Append
Hostname feature to add the device hostname, e.g. TLR6200-60007-AO0IP to a Source.
This will create unique RAVENNA names which is important. If this feature is not used
and the same advertised RAVENNA names exist on different devices, some may either
not be displayed, or the panel may display randomly appended RAVENNA names. This
makes it very difficult to find and identify the correct stream.

e The codec hostname can be changed in the AolP Host Network panel accessed from
the AolP menu in either the HTML5 Toolbox Web-GUI or the AolP Web-GUI.

Click Save to store settings.
The Services panel displays when RAVENNA is running successfully.

Configure the Codec for RAVENNA Streaming

Before streaming audio from the codec using RAVENNA it is necessary to configure the AolP
mode correctly.

1.

2.
3.

Open the HTML5 Toolbox Web-GUI and click Settings at the top of the screen, then click
Audio to display the Audio Options panel.

Click Edit to adjust settings.

Click the drop-down menu for Audio over IP Mode and select Native AolP Protocols.
Click Save.
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Configure a Tieline Destination to Receive a RAVENNA AolP Stream

After RAVENNA has been enabled as a service in the codec it is simple to discover RAVENNA
Sources from other devices over an AolP network. Tabs are displayed in the Destinations panel
for RAVENNA.

Configure a Destination using the RAVENNA Tab

The RAVENNA tab displays available RAVENNA Sources. Also note:

The Hostname is the Hostname of the actual device/box, e.g. codec.

The Address is the IP address of the device.

The Port is the RTSP port used to fetch SDP data.

The Interface is the AolP Port on the codec used to connect to the external device.
The Domain is always local when using mDNS.

To configure a Destination using the RAVENNA tab:

1. Click Refresh to display all available RAVENNA Sources advertised on the AolP network.
At the top of the tab there are search fields to filter available Sources. Note: A progress
bar may be displayed if a very large number of network streams need to be populated in
the RAVENNA tab.

2. Select the Name of the preferred RAVENNA Source. Note: When a Source is selected,
SDP data is fetched, parsed and populated in the fields within the Destinations panel.
Confirmation that SDP has been successfully parsed is also displayed at the bottom of the
RAVENNA tab.
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3. Click Save to store the new Destination settings.

Configure a Destination using the RAVENNA URL Tab

Use the RAVENNA URL tab to copy or create a known RTSP URL address for a device and then
paste it into the RAVENNA URL tab to populate data in the Destinations panel.

For example, a Tieline codec RTSP URL by stream name would use the format
"rtsp://192.168.87.213/by-name/Tieline%20SRC%2009". The "%20" is used to replace the spaces
in the codec name in this example, but is not essential. It is also possible to create an RTSP URL
using the device stream |ID, which is the index number of the stream, e.g.
"rtsp://192.168.87.213/by-id/8". This example populates data for the 8th stream on the codec.

Click Apply URL to fetch, parse and populate SDP data in the Destination panel fields.

Configure Devices using the HTTP Nodes Tab

RAVENNA allows advertisement of web management interfaces controlling devices to which you
are connecting. The HTTP Nodes tab displays Hostname and Address links to directly launch the
device management interface for advertised RAVENNA devices on your AolP network. This
facilitates easy control of advertised devices across a network.
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1. Click Refresh to display all available nodes advertised on the AolP network. At the top of

the tab there are search fields to filter available Sources.

2. Click Hostname or Address links to launch a device's browser-based interface.

Configure a Tieline Source as a RAVENNA AolP Stream

To advertise a Tieline codec Source as a RAVENNA AolP stream across an AES67 network it is

necessary to:

1. Ensure RAVENNA as a service is Enabled and Running in the Services panel.
2. Configure Source settings and then select the RAVENNA check-box in the Sources panel

and save these settings.
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1.10 Enable Livewire and Use Pathfinder

Livewire is a proprietary AolP system developed by the Telos Alliance and Livewire+ AES67 is the
second generation of Livewire which is AES67-compliant. Tieline G6 codecs from firmware
release v3.06.xx can interface natively with Livewire and Livewire+ AES67 systems over an
AES67 LAN. This facilitates codecs supporting Livewire+ stream discovery and advertisement, as
well as GPIO and Program associated data. For details on Livewire clock settings see the
Clocking section of this manual.

Enabling Livewire+ in the Codec

To configure the codec to use Livewire+:

1. Open the AolP Web-GUI and select Services to display the Services panel.

2. Click Edit in the Livewire Settings panel to adjust settings. Note: Click Change Password
to enter a Livewire password for Pathfinder software.

3. Livewire devices provide a fast setup routine using a Node ID to assign 1/O channel
numbers quickly. Enter a unigue Node ID with a value within the range 1 - 319. Note: 16
sequential Livewire Channels are assigned from the entered Node ID.

4. If the check-box for Livewire Channels is selected, the Source channel numbers and
addresses are automatically assigned within the codec.

Livewire Settings
Status Off
(D Enabled v
Node ID 2

Livewire Channels 201-216 | ,

Settings 8 x Stereo v

Change Password

5. Use the Settings drop-down menu to configure Source streams. Selections include:

a. Custom only changes the IP addresses of existing Livewire Channels.

b. The other options configure the codec for the preferred number of inputs per Livewire
Channel (stream), e.g. 8 x Stereo, 16 x Mono, or 2 x Surround. Note: Livewire
Channels available depend on how many inputs/outputs are supported in the codec, e.qg.
4, 8 or 16.

6. Select the Enabled check-box and then click Save. Note: It can take up to a minute for

Livewire to start running.
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Livewire Settings
Status Running
(D) Enabled v
Node ID D

Livewire Channels 201-216

Settings 8 x Stereo v

Edit Livewire settings saved successfully. x

Important Notes:

o |t is not possible to enable Livewire as a service if the sample rate is not configured
as 48kHz.

e Assign a Node ID and Livewire channels in the codec first before creating any
RAVENNA, SAP, or AES67 streams.

e When a Node ID is configured in the codec any existing Livewire channels and
streams are reconfigured.

o Livewire Channel Numbers are assigned in blocks of 8.
e 16 sequential Livewire Channels are assigned from the entered Node ID, even if a codec

supports fewer inputs and outputs.

Configure the Codec for Livewire Streaming

Before streaming audio from the codec using Livewire+ it is necessary to configure the AolP mode
correctly.

1.

2.
3.
4,

Open the HTML5 Toolbox Web-GUI and click Settings at the top of the screen, then click
Audio to display the Audio Options panel.

Click Edit to adjust settings.

Click the drop-down menu for Audio over IP Mode and select Native AolP Protocols.
Click Save.

Configuring a Codec for Use with Pathfinder

Pathfinder Server communicates with all Livewire system nodes and supports virtual routing, audio
metering, silence detection, and Livewire GPIOs. Livewire systems can also be controlled using
Pathfinder PC.

Adding a Tieline Codec to Pathfinder Server

When you attach a new codec to your network you need to add it using Pathfinder Server. Ensure
that it has been added to Pathfinder Server.

1.

Launch Pathfinder Server software.
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E PathFinderSenver - DESKTOP-500HTKG - m} x
File View Preferences Help
Routers T Events Stacking Events TProtocoITransIatorT Panels T Logs T Clustering
[ 1D [Mame Diescription | P
» | 1 |Audio Router | m

Add Remove Edit
Router Router Router

2. Click Edit Router and select Next.

3. Click Next again and select the Network to Scan, then click Scan.

E7 Livewire Router Setup Wizard x
Utilities
Add Livewire Terminals
Select Networks to Scan:
Network IP Base Add... | Network IP Mask |
[1472.46.99.27 265.256.0.0

To Find Livewire Terminals Automatically - Click Scan
Scan [} | Stop |

Timeout| 1/2 Second vl

-Node-01
TLR6200-61086-A0IPa
ZIPOne
Add +-— TLR6200-60007-AOIP
------- LAWOCTRL-WIN10
Remove
Scan Progress |

Cancel ‘ <<Back | Next>> Einish |

Important Note: Ensure Livewire is enabled in the Services panel of each codec before
performing a network scan.
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Status Running

(1) Enabled v

Node ID 2
Livewire Channels 201-216

Settings 8 x Stereo

Livewire settings saved successfully. x

4. Pathfinder Server will scan the AolP network for new devices and any detected will be
displayed (codec model and serial number), then click Next. Note: If devices are not
automatically detected click Add to manually add them into Pathfinder Server.

Utilities

E Livewire Router Setup Wizard

Add Livewire Terminals
Select Networks to Scan:

X

Network IP Base Add... | Network IP Mask

[]172.16.99.27

255.255.0.0

192.168.87.146

255.255.255.0

To Find Livewire Terminals Automatically - Click Scan

Timeout| 1/2 Second -

-ZIPOne
Add

-Node-01
-TLR6200-61086-A01Pa

-TLR6200-60007-A0IP
-LAWOCTRL-WIN10

Remove

Scan Progress|

Cancel

Scan Finished.

<<Back ‘ Next=> ‘

5. Set the passwords for each new device, then click Next. and then Finish in the Testing

Login Access dialog.

E Livewire Router Setup Wizard

Utilities
Store Terminal Passwords to Database
In order for this sy to and make ch to the

Livewire Terminals, the System needs to know the Password
for each Livewire Terminal.

Select the Terminals in the list and then click
"Set Password" to program the Password into

the database.
Name IP Address
Node-01 192.168.87.29:93
TLRG6200-61086-A0IPa 192.168.87.130:93
ZIPOne 192.168.87.134:93

192.168.87.162:93
192.168.87.191:93
192.168.87.144:93
192.168.87.169:93

TLRG6200-60007-AQIP
LAWOCTRL-WIN1O

TLRG6200-60014-A0IP
TLR6200-60012-A0IP

Cancel <<Back ‘ Next=> ‘ ‘

£

| Utilities

Testing Login Access

Name [1e | Login succe ~
TLRG200-61086... 192.168.87.13.. True

ZIPOne 192.168.87.13... True
TLR6200-60007... 192.168.87.16.. True
LAWOCTRL-WI... 192.168.87.19... True
TLRE200-60014... 192.168.87.14.. True
TLRG200-60012... 192.468.87.15.. True .
< »
LoginProgress:| | ogin Testing Complete.

<<Back

Cancel

‘ Einish[ ‘
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6. To double-check that the codec has been added to Pathfinder Server select View > Device
List.

E PathFinderServer - DESKTOP-509HTEG i

File | View Preferences Help
| -
ScriptDebugger Stacking Events TF'rotocoI Translato

Derreeiat b D escription

7. Inthe following image the newly added codecs display as "TielineGateway".

E Device List — m] ®
Router Name | # |Device P Device Type | connection State
[=] Audio Router 1
[ Node-01 192.168.87.29 axiaxnode.analogd Connected
~[1 TLRE200-61086-40IF: 192.168.87.130 TielineGateway Connected
-1 ZPOne 192.168.87.134 ZIP ONE Connected
~[] TLRE200-60007-A0IP 192.168.87.162 TielineGateway Connected
-] LAWOCTRL-WIN10 152.168.87.191 Iwrwed Connected
-1 TLRE200-50014-A0IP 152168 87.144 TielineGateway  Connected
] TLRE200-60012-A0IP 1582.168.87.158 TielineGateway  Connected
Feszend Init Reconnect
Done —_—

Using Pathfinder PC

After adding your codec to Pathfinder Server, launch Pathfinder PC and select File > Connect to
Server and click Connect.

E} PathFinderPC Demo

File Routers S5cenes Meter Bridge Toolbars View Window Help

Router or User Group

- ﬂ Connect To Server

(+ Routes " Scenes IP Address [172.16.99.27
Port: [5200

—

It should now be possible to route Sources and Destinations through the codec using
PathfinderPC.

£ Audio Router A meter Bridge | = || .= |

b R FProdl 112334

Prod1 11233
SRC 2
Axia SRC 3
SRC4
SRC S . .
SRCE
SRCT
SRC &
Zip1 LW103

Tieline SRC 03
Tieline SRC 04
Tieline SRC 05
Tieline SRC 06

Lisa

180 Xo0gx3
£1sd

visa

s1sd

91sd

1180

81sa
umouyun

JaLLIBIU| JUBIGUIY
YEETLL LPOId

20 180 ouneLL
[NEETRETN

L=
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1.10.1 Livewire+ Streaming

Product Feature Notification

Gateway 4 | Livewire Supports up to 4 mono or two stereo streams.
streams

Gateway Livewire 16 channel Gateway supports up to 16 mono or 8 stereo

8/16 streams streams; 8 channel Gateway supports up to 8 mono or 4 stereo

streams.

MPX | Livewire Configure two mono Source/Destination streams, or a single
streams stereo Source/Destination stream.

MPX I Livewire Configure up to 4 mono or 2 stereo Source/Destination streams.
streams

Bridge-IT Il Livewire Configure two mono Source/Destination streams, or a single

and Bridge- | streams stereo Source/Destination stream.

IT XTRA Il

Livewire Compatible Destinations: Receiving a Livewire+ Stream

The Livewire tab in the Destinations panel lists all available Livewire+ Sources.

Configure a Destination using the Livewire Tab

The Livewire tab displays available Livewire+ Sources alphabetically. At the top of the tab there
are search fields to filter available Sources. Note: A progress bar may be displayed if a very large
number of network streams need to be populated in the tab.

e The Name is the name of the stream.
e The Address is the multicast IP address used to create the Destination stream.
e The Channel is the unique channel number used by Livewire to identify streams.

To configure a Destination using the Livewire tab:

1. Click Refresh to display all available Livewire Sources advertised on the AolP network.

2. Select the Name of the preferred Livewire Source. Note: When a Source is selected, SDP
data is fetched, parsed and populated in the fields within the Destinations panel. A
message at the bottom of the Livewire tab confirms that SDP has been successfully
applied.
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Destinations (Device — Tieline)

Status Idle HTTP Nodes Livewire Manual SDP RAVENNA RAVENNA URL SAP

Name PC 1 Percuss Name Address Channel
Address 239.192.7.208
Channel 2001 PC 1 Percuss@LAWOCTRL-WIN10 239.1927.208 2001
UDP Port 5004

PC 2 Choral @LAWOCTRL-WIN10 239.1927.210 2002
Interface AolP Port 1 $

PC 3 Flamenc@LAWOCTRL-WIN10 239.192.7.211 2003
Codec Type L24 B

PC 4 Indie@LAWOCTRL-WIN10 239.192.7.212 2004
Maode 2 Channel s

PC5 Rock@ OCTRL-WINTO 239.192.7.213 2005
Type Stereo E

PC 6 Orchest@LAWOCTRL-WIN10 239.192.7.214 2006
Enable Discovery NMOS

PC 7 Voice@ LAWOCTRL-WIN10 239.192.7.215 2007
Livewire Compatible Enable i

PC & Countrv@LAWOCTRL-WIN10 239.192.7.216 2008

Type From Source (Live or Standard) hd
(@ Syntonous Enable |«
Livewire settings fetched successfully.

(D Buffer Depth 10 ms | = | 480 samples

Settings have been applied.

Show Advanced Settings

Cancel Save

3. Click Save to store the new Destination settings.

Livewire Compatible Stream Type

The Livewire Compatible stream Type is typically configured when a Livewire stream is parsed
using the Livewire tab. It can also be manually configured using the Type drop-down menu.

Livewire Compatible Enable e

Type To Source (Back Standard) v

Custom
From Source (Live or Standard) k
To Source (Back Standard)
Show Advanced Settings To Source (Back Live)
h Surround

@ Link Offset 10

4gld Redundant Siream

Type drop-down menu

A stream type can be defined as:

1. Custom: This is an AES67 mode that allows you to override and modify Livewire settings
which are non-standard.

2. From Source: Also known as Livestream or Standard streams using the Livewire address
range 239.192.000.0/15

3. To Source: Also known as Back Standard Stereo Streams using the Livewire address
range 239.193.000.0/15

4. To Source: Also known as Back Live streams using the Livewire address range
239.193.000.0/15

5. Surround: Surround streams using the Livewire address range 239.196.128.0/15

Stream type is explained in more detail in the following topic about creating a Livewire+ Source.

Important Notes:
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e When a Livewire Compatible stream is configured the Downmix option is only
selectable for a Custom stream type. Other stream types are automatically configured.

e When configuring a mono Destination stream, if a stereo RAVENNA, SAP or Livewire
stream is parsed, then Downmix will be automatically selected for compatibility.

e Syntonous receive mode is enabled by default in Livewire Destinations. In Syntonous
mode the sampling frequency is locked, but the absolute time reference at the sender
and receiver may be different. If you experience streaming issues adjust the buffer
depth to suit network latency conditions.

(D Syntonous Enable |« '

(D Buffer Depth 10 ms | = | 480 samples 1

o If a non-standard Livewire address is configured then a message will be displayed
below the Address field in the Destinations panel.

Name Axia SRC 3 J

Address 239.192.03 4

h skt ......-#-,_}A“_—_,

Livewire Channels

Livewire uses multicast addresses for AES67 and unique addressing Channels for Livewire, which
are automatically calculated. Livewire channels range from 0 to 32767.

If we assume a multicast IP address is 239.192.35.48 then the Livewire Channel number is
calculated as follows:

IP address = 239.192.35.48
To calculate multiply 35 x 256 + 48 = Channel number 9008

Configure a Tieline Source as a Livewire+ Stream

To advertise a Tieline codec Source as a Livewire+ AolP stream across an AES67 network it is
necessary to:

1. Ensure Livewire as a service is Enabled and Running in the Services panel.

2. Configure Source settings including the Channel number and then enable the Livewire
Compatible check-box in the Sources panel.

3. Select the preferred Livewire+ Stream Mode to suit the type of Source being configured.

4. Click Save when all settings are configured.
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Sources (Tieline — Device)

Status Idl=

Name Tieline SRC 09
Address 23819208
Channel :
UDP Port 5004
Interface AolP Port 1
Frame Size 250 microseconds
Codec Type L24
Mode 8 Channe
Type Mono
@ Upmix Enable v
Enable Discovery SAP NMOS RAVENNA
Livewire Compatible Enable »/
Stream Mode | Custom v

Custom

Show Advanced Settings

Back Live

Add Redundant Stream Standard

Back Standard
Surround

When the stream mode is selected it configures the Livewire address range and packet structures.
The settings include:

1.

2.

Custom: This is an AES67 mode that allows you to override and modify Livewire settings
which are non-standard.

Live (also known as Livestream) streams use the Livewire address range 239.192.0.0/15:
Total bytes per packet = 72; Core delay = .25ms.

Back Live streams use the Livewire address range 239.193.0.0/15: Total bytes per packet
= 72; Core delay = .25ms.

Standard streams use the Livewire address range 239.192.0.0/15; Total bytes per packet
= 1440.; Core delay = 5ms.

Back Standard Stereo Streams use the Livewire address range 239.193.0.0/15; Total
bytes per packet = 1440.; Core delay = 5ms.

Surround streams use the Livewire address range 239.196.128.0/15: Total bytes per
packet = 1440; Core delay = 1.25ms.

Important Notes: When a Livewire Compatible stream is configured the Upmix option is
only selectable with the Custom Stream Mode. Other options are automatically
configured.

1.10.2 Livewire GPIOs

64 Livewire GPIO ports are supported in the codec. Livewire uses ports to activate GPIOs and
ports 1-8 are configured with 5 GPIs and GPOs. Port 9-16 are configured with 3 GPIs and
GPOs. These inputs and outputs are also mapped to 64 Tieline GPIs and GPOs as displayed in
the Livewire GPIO panel in the AolP Web-GUI.
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Livewire GPIO panel displaying the first 10 GPIOs

In general Livewire devices think of GPIs as signals going to the network and GPOs as signals
coming from the network. A Livewire port can be configured in 3 ways:

1. Port routing with Tieline's browser-based AolP Web-GUI: GPI activity on a port will trigger
the GPO of the port being configured. To do this enter the IP address of the device,
followed by a forward slash and the port number.

2. Channel assignment with Tieline's browser-based AolP Web-GUI: The GPIO port will
follow the logic defined by a control surface (or the codec) through the use of the unique
channel number loaded to a fader or other console functionality.

3. Pathfinder PC Server software can monitor and control GPIO pins on any of these ports
using its event system. It can also route closures using the IP address and port humber.

In the IP Address/Port example, the GPIO device opens a TCP connection to the routed GPIO
device and monitors the GPI pins tripping its own GPO pins. In the Livewire Channel number
example, GPIO messages are sent as multicast messages in the same way as multicast audio
traverses the network. A device monitors the GPIO multicast channel for closures tagged with the
correct Livewire Channel number.

Configuring a Livewire GPIO with the Codec Web-GUI

Livewire GPIOs can be configured using the Tieline HTML5 web-GUI. First, select the Enable
Livewire GPIO checkbox in the Options panel of the HTML5 Toolbox Web-GUI to use Livewire
GPIOs.

Program and stream level Livewire GPIO rules can be configured using the Program Manager
panel when creating new programs.
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The Rules panel can also be used to create Livewire GPIO rules for hardware or virtual 10s.

See the "Creating Rules" section in the codec user manual for more detailed information on
configuring rules.

1.10.3 AESG67 Streams and Livewire

Tieline recommends sending and receiving Livewire+ streams in natively supported Livewire
Compatibility mode. It is also possible to send and receive AES67 streams between the codec
and Axia Livewire systems. The following AES67 configuration information was tested using an
Axia XNode with firmware version 2.4.7.

xNode Synchronization Settings and SAP

During testing the following settings were applied to the xNode and SAP Announcements (in the
Synchronization menu) were enabled to allow discovery.
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Configure a Tieline Source and an xNode Destination

The Destinations page in the Axia xNode web-GUI defines the audio outputs of an xNode. There
are 4 stereo output ports and these outputs may be the physical outputs of the unit, or network
stream inputs, such as an AES67 Source stream from a Tieline codec. To receive the Source
audio from the Tieline codec the xNode destination DST 1 in the following image is configured to
connect to:

e Multicast address 239.33.1.0.
e UDP port 5004.
o 124 (24 bit) sampling at 48kHz in stereo.

After configuring the xNode click Apply.

The Tieline codec Source configuration using the Tieline AolP Web-GUI for Tieline SRC 01 is as
follows:
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Sources (Tieline — Device)

Status Idle

Name Tieline SRC 01

Address 2393310

UDP Port 5004

Interface AolP Port 1 B
Frame Size 125 microseconds s
Codec Type L24 E
Mode 2 Channel s
Type Mono $
Enable discovery SAP NMOS RAVENNA

Show advanced settings

Add Redundant Stream

Cancel Save

Once configured, click the Start symbol > to commence streaming. In the following configuration
example, the Tieline codec is streaming Source audio to the xNode over multicast address

Sources (Tieline — Device)
Action Index = Name Status PPM IPV4 Address Remote UD... Mode Fram...
P T e T T T a2
I{ﬁ} a 1 Tieline SRC 01 Running !! 239.33.1.0 5004 2 Channel 250us
{ﬁ} o 2 Tieline SRC 02 Running I = 239.33.1.1 5004 250ps
{ﬁ} a 3 Tieline SRC 03 Running ! ! 239.33.1.2 5004 250pus
Running

In the xNode audio is received and can be monitored in the xNode web-GUI Meters page via DST
1 in this example.

Configure a Tieline Destination and an xNode Source

The xNode can transmit a multicast stream to a Tieline codec once a Source has been configured
with a multicast IP address and the Stream Mode is set to a value other than disabled, e.g. Stereo
1ms (AESG67), or Live Stereo which supports 250 microsecond packet timing. After configuring the
xNode click Apply.
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An example of the Tieline codec Destination configuration using the Tieline AolP Web-GUI is as
follows:

Download an SDP File from an xNode

To download the configuration info for an audio stream from an xNode:

1. Click Download stream description (SDP) for a Source audio stream on the xNode and
save it to a PC.

Sources
# Source Mame: Channel/Address: Stream Mode: Input Gain [dB]:
Line 1 | prod1 112334 239.1.1.0 [ Live stereo v 150 |
AESE?:l_oﬁnliad_shEal:LescLipti_oniSE RTSP: risp://192.168.87.29/by-id/1
2 [spc2 | [239.1.1.1 | [Live stereo v [ar7 ]
AES67: Download stream description (SDP), RTSP: risp://192.168.87.29/by-id/2

2. Onthe Tieline codec open the Destinations panel and ensure the stream being configured

is not active. Click the Configuration symbol & for a Tieline Destination audio stream
and select Upload SDP and then select the xNode SDP saved to the PC.
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3. The SDP settings within the file are parsed and applied to the Tieline codec Destination
audio stream as displayed.

4. Click Save to store these settings.

5. Click the Start symbol D> to receive stream audio. In the following configuration example,
the Tieline codec is receiving audio from the xNode Source via multicast address 239.1.1.0.

Troubleshooting

During testing, in 8 channel streaming mode the xNode required an RTP Payload Type of 99 and
testing was successful with a 1ms frame size. The Payload Type setting is available in the
Advanced Settings menu in the Sources panel. | think they only support 1ms packets in 8
channel mode.
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1.11 Dante Streaming

A Tieline Gateway with an optional Dante card on-board can interface directly and seamlessly
with other Dante compatible devices. Audio stream source and destination routing can be directly
configured using Dante Controller software.

Configuring the Codec for Dante

Before streaming audio from the codec using Dante it is necessary to configure the codec Audio
over IP Mode correctly.

1. Open the HTML5 Toolbox Web-GUI and click Settings at the top of the screen, then click
Audio to display the Audio Options panel.

2. Click Edit to adjust settings.

3. Click the drop-down menu for Audio over IP Mode and select Dante.

Audio Options x
@ Audio over IP Mode Dante v
Digital Input Type Audio over IP w
Digital Output Type Audio over IP v
AES Output Clock Lock to Dante Clock w
PPM Mode Decoder v
Analog Input PPM Units | dBFS v
Reference Level Auto v

Save Cancel

Important Notes:

¢ |f Dante is not displayed as an Audio over IP Mode option then a Dante license may
not be installed in the codec. There are two ways to update this:

= Check the Licensing panel in the Toolbox HTML5 Web-GUI to verify if the Dante
license is listed. If it is not listed, and the codec is connected to the internet, click
Get license file from TieServer to install the Dante license.

= Using the codec front panel screen navigate to Settings > System > Licenses and
press the OK button for Update From TieServer.

o If the codec is not connected to the internet, contact Tieline and notify us of the serial
number of your codec to request a Dante license file. Then use the Upload a selected
file option in the Licensing panel to upload the license file provided by Tieline.

o If Dante is displayed as an Audio over IP Mode option, but not selectable, then the
Dante card is likely not fitted, or not fitted correctly.

4. Both the Digital Input Type and Digital Output Type in the Audio Options panel can be
configured for Audio over IP. Note: It is possible to configure the codec to use Dante AolP
inputs and AES3 outputs or visa versa. In these situations the AES Output Clock should
be set to Lock to Dante Clock, unless the selected clock is definitely synchronized to the
Dante clock. In most cases, the AES Output Clock should be set to Lock to Dante
Clock.

5. Click Save to save settings.

The Audio over IP Mode can also be configured using the front panel of the codec:

1. Press the SETTINGS button.
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2. Use the navigation buttons to select Audio Options and press the button.
3. Select AolP Mode and press the button.
4. Select Dante and press the button.

Important Notes:

e When the AolP Mode is changed we strongly recommend rebooting the codec using
either the Reset / Backup panel in the Toolbox Web-GUI, or by navigating to Settings
> Reset & Backup > Reboot Codec via the codec front panel.

o Advertisement, discovery and streaming is only available using the AolP 1 port when
using Dante. Redundant AolP streams are not supported when using Dante.

o Native AES67 will not run when the Audio over IP Mode is set to Dante.

Configure Flows with Dante Controller

1. Launch Dante Controller software on your PC after configuring Dante as the AolP Mode.
2. The codec should appear in the Device Info tab.

3. Double-click the device to open the Device View dialog and configure Dante flows.

Important Notes:

e The AolP Sources panel and AolP Destinations panel are disabled in the AolP Web-
GUI and HTML5 Toolbox Web-GUI when the codec is configured for Dante AolP Mode.

e The Synchronization panel is disabled in the AolP Web-GUI and HTML5 Toolbox Web-
GUI when the codec is configured for Dante AolP Mode. Dante handles clocking
automatically via election and the codec will automatically sync to the Dante clock. Over a
Dante network a "Primary Leader Clock" device is automatically assigned, even if more
than one "Preferred Leader" is configured.

1.11.1  Dante AES67 Streaming

Dante is a proprietary AolP system developed by Audinate which also supports AES67 streaming.
Tieline AES67 enabled codecs support streaming AES67 audio between Dante enabled devices.
Dante Controller is the software interface used to manage Dante devices and to establish audio
stream routing between devices. Dante Controller is a free download and AES67 and SMPTE ST
2110-30 RTP streaming is supported from v4.2.x of this software.

For a Dante device to connect using AES67 it needs to be AES67 compatible and not all devices
are. Sometimes a firmware upgrade may be possible to add AES67 support, so verify if this is
possible if AES67 is not available in a Dante device.
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Sources, Destinations and Flows

Tieline and other AES67 compatible devices usually refer to multicast audio streams as Sources
and Destinations, whereas Dante calls these streams "flows." Dante devices in AES67 mode can
transmit and receive AES67 multicast flows to and from non-Dante AES67-enabled devices.
However, between Dante devices Dante's native audio transport protocol is used, even when
AESG67 is enabled on the Dante devices.

Dante Clocking

Dante handles clocking automatically via election and each Dante device includes a clock using
IEEE1588 PTP. Over a Dante network a "Primary Leader Clock" device is automatically assigned,
even if more than one "Preferred Leader" is configured. More information on clocking is available in
the Clocking section of this manual.

Discovery: Displaying AES67 Sources within Dante Controller

To display Tieline codec Sources within Dante Controller:

1. Inthe AolP Web-GUI select Sources (or in the HTML5 Toolbox Web-GUI click AolP and
then Sources to open the Sources panel).

2. Select a source, then select Settings and select the Enable Discovery checkbox for SAP
in the Sources panel.

Enable discovery SAP v NMOS

Show Advanced Settings

P \)_)-..__.....J

3. Save the setting, then start the Source stream and ensure it is Running.

g

Setting up a Dante Device for AES67 Operation

It is necessary to configure an AES67 compatible Dante device to stream in AES67 mode. In the
following example the device connected to Dante Controller is an EXBOX.MD AolP to MADI
converter. It is assumed that the user has some knowledge of how to use Dante Controller. Note:
The following procedures were created using Dante Controller version 4.3.3.15.

1. In Dante Controller select Devices > Device View.
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2. Select the device to which the codec will send or receive AES67 streams.

3. Select the AES67 Config tab in the Device View and ensure the AES67 Mode is Enabled.
From v4.2.x of Dante Controller it is not necessary to reboot a device to reconfigure this
setting. It is also possible to reconfigure the RTP Multicast Address Prefix for situations
where it is necessary to transmit or receive streams from a particular address range.

© Tieline Research Pty. Ltd. 2024



80

AolP User Manual v1.7

Important Note:

o If the AES67 Config tab is not displayed for a device it is probably either not able to
stream in AES67 mode, or will require a firmware update to upgrade it for AES67
streaming if this is available.

e The multicast address prefix configured at the Dante device level (239.5.xxx.xxx in
the preceding example), does not affect which AES67 flows (streams) from non-
Dante devices are displayed in Dante Controller. However, when subscribing a
Dante device to a non-Dante Source stream (Tx flow), the multicast address prefix
set for the receiver must match that of the Source stream. In other words, a Tieline
Source stream should use the multicast address prefix configured in the Dante
device. Otherwise, if they do not match, the multicast Source subscription will
appear to succeed, but audio will not actually flow/stream to the Dante device.

4. Select the Device Config tab in the Device View. Verify settings like the Sample Rate of

5.

48k and PCM 24 bit are selected to match the Tieline Source and Destination streams. The
Latency setting of 2.0 msec is recommended for most networks, but 5 msec can be
configured for stability on Dante devices if required.

In Dante Controller confirm the Dante device is synced to the Primary Leader Clock on the
AES67 network using the Clock Status tab.
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Create a Tieline Source Stream and Configure a Dante Flow to Receive

Audio

1. Configure a Source in the Tieline codec using similar settings to the following image. Notes:
Ensure the Enable Discovery SAP check-box is selected. The multicast address prefix
configured must match prefix in the Dante device receiving the stream. E.g. 239.5.XXX. XXX

Sources (Tieline — Device)

Status Idle

Name Tieline SRC 01

Address 239.5.1.0

UDP Port 5004

Interface AclP Port 1

Frame Size 125 microseconds

Codec Type L24

Made 2 Channel

Type Stereo

Enable discovery  SAP v NMOSs RAVENNA

Hide advanced settings

Time To Live (TTL) 5

QoS DSCP 34 AF41 (AESET recommended) ~
VLAN Priority Disabled
Payload Type 96

Add Redundant Stream

Cancel Save

2. Verify audio is metering on the Source PPMs and click the Start symbol D> to start
streaming. Running appears in green when streams are successfully streaming.

3. Launch Dante Controller and the Tieline codec Source streams should be populated at the
top. In the example below, Glenn TIELINE SRC 01 has been successfully routed via the
crosspoints to the EXBOX Receiver (Destination) Channels 1 and 2.
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4. In Dante Controller select Devices > Device View and then select the Dante device and
view the Receive tab. The green ticks and green speaker icons on each channel confirm
Tieline Source audio is being received as a Dante 'flow".

5. Other Tieline and non-Tieline Source streams can also be routed as required.
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Create a Dante Tx Flow and a Tieline Destination Stream to Receive Dante
AESG67 Audio

1. In the Dante Device Manager menu select Device > Create Multicast Flow, or click the

Create a new multicast flow symbol.

2. Select AES67 as the Audio Flow Config and leave the Destination Address setting as
Auto. Next, select the channels to add to the new Dante flow (which will be the destination
Tieline stream). Two channels are configured in the following example, however Tieline

supports connecting up to 8 channels in AES67 streams between Dante devices. Finally,
click Create.

& Create Multicast Flow x

EXBOX-MD-14865¢ supports up
to 64 channels per flow.

RTF flows for AES67 have a maximum of 8 channels per flow.

Select one or more transmit channels to be placed in multicast flows,

Audio Flow Config (Optional)

) Dante @ AES67
Destination Address: @ Auto I} O Manual
Channel O Add to
Hame Hew Flow

{3 Ch 1EXBOX
{3 ch 2 ExBOX
Qcha
(ICh4

~

OORA

Cancel

3. The new multicast flow is presented in the Transmit tab of the Device Manager and the
green speaker symbols confirm audio is present.
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4. Next, configure a Tieline Destination stream with the multicast IP address displayed in the
Device Manager and the same port, frame size, sample rate and codec settings.

5. Alternatively, Dante devices support SAP so it is possible to use the SAP tab in the
Destinations panel to discover streams. Select the SAP tab and then select a stream to

view stream details. Select Apply SDP to configure the Destination stream automatically
using the displayed SAP data.

6. Save the settings and click the Start symbol D> to stream audio from the Dante device.
Running displays when streaming and PPMs should meter audio.
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1.12 LAWO AES67 Streaming

Connectivity tests with RAVENNA AES67 interoperability were conducted using a LAWO Power
Core using firmware v.6.4.1565.

Getting Started with LAWO over AolP

In testing the following settings were successfully configured in the Synchronization panel in the
Tieline AolP Web-GUI. Note: Verify the LAWO settings are the same as they should match on the
Tieline and LAWO devices.

1. Global Sample Rate is 48kHz.
2. Domainis set to 0.
3. Delay Mechanism is set to E2E.

Check that PTP synchronization is running correctly on the device to which the Tieline codec will
connect.

Important Notes:

e PPMs for AolP streams are visible when viewing Sources and Destinations using the
Tieline AolP Web-GUI if a computer is connected to the AES67 LAN at the studio.

e The AolP Web-GUI also displays all the panel settings available within the AoIP menu in
the Toolbox Web-GUI, however it looks quite different.

Set up a LAWO Power Core to Receive a Tieline 'Source' Stream

Configuration of the LAWO Power Core over an AES67 LAN in testing required the setup of
installed LAWO ON-AIR Designer software as follows:

1. Configure the RAVENNA input to receive the Tieline codec source. This includes the
Stream Size, UDP Port No. and the Default Stream name.
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2. Configure the AolP AES67 stream, including the Stream Name, Stream Size, Samples
Per Frame, Codec and Multicast IP Address, Multicast UDP Port No. and the RTP

Payload Type is 96.

Note: When configuring Tieline codecs please note that Frame Size is displayed in
microseconds or milliseconds. Some products like LAWO use Samples Per Frame instead. It
is possible to calculate the relevant setting using the following table:

Packet Time | Packet samples | Packet Samples | Packet Samples Notes
(48 kHz) (96kHz) (44.1 kHz)
125 microseconds 6 12 6 Compatible with
class A AVB
transport
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250 microseconds 12 24 12 High-
performance,
low-latency
operation.
Interoperable
with class A
and compatible
with class B
AVB

transport

333 microseconds 16 32 16 Efficient low-
latency
operation

1 millisecond 48 96 48 Required
common packet
time for all
devices adhering
to AES67
standard

4 milliseconds 192 NA 192 For applications
desiring
interoperability
with EBU Tech
3326

or transport over
wider areas or on
networks with
limited QoS
capability

3. Using ON-AIR Designer save the configuration and select Transfer > Config to Unit and
wait for the configuration to be uploaded.

4. Navigate to the RAVENNA screen and select the Outputs (Device to Core) tab, then click
Connect to start activate the AES67 source stream from the Tieline codec.

5. Inthe Source screen within the Tieline AolP Web-GUI click the Configuration symbol &
and then select Start to commence streaming. The configured source should display
outgoing audio to the LAWO device on the PPMs.

Set up a LAWO Power Core to Send a 'Destination’ Stream to a Tieline
Codec

A device streaming AES67 audio to a Tieline codec will normally be configured with a destination
multicast IP address. This IP address is then entered into the Destination screen on the Tieline
AolP Web-GUI to receive the stream. Configuration of the LAWO Power Core over an AES67 LAN
in testing required the setup of installed LAWO ON-AIR Designer software as follows:
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1. Configure the RAVENNA output to send the Tieline codec destination audio. This includes
the Stream Size, UDP Port No., Stream Name, Codec and IP Address as displayed.

2. Using ON-AIR Designer save the configuration and select Transfer > Config to Unit and

3.

4,

wait for the configuration to be uploaded.

In the Ruby Power Core Web-GUI click Enable to start the Destination stream.

In the Destination screen within the Tieline AolP Web-GUI click the Configuration
symbol {S¥ and then select Edit to enter the Destination multicast node 1P address, then

click Save.
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Status Idle

Name Tieline DST 03

Address 239.87.99.1

UDP Port 5004

Interface AolP Port 1 s
Codec Type L24 i
Type Stereo s

Enable Discovery NMOS
Livewire Compatible Enable

@ Link Offset 10 ms | = 480 samples
Show Advanced Settings

Add Redundant Stream

Cancel Save

5. Next click the Configuration symbol ¥ and then Start to commence receiving the AES67
audio stream from the LAWO device. The configured Destination should display incoming
audio from the LAWO device on the PPMs. Verify input audio is displayed on the codec to
confirm audio is being received ok.
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1.13

Troubleshooting AES67 and WheatNet

Some things to check if AES67 streaming is not working include:

1. Check the PTP clock synchronization in the Tieline codec and the device to which it is
streaming and confirm they are locked and synchronized. This is verified in the AES67
Synchronization panel in the Tieline codec's HTML5 Toolbox web-GUI, or the
Synchronization panel in the AolP Web-GUI if this is accessible.

2. During testing, in 8 channel streaming mode the xNode required an RTP Payload Type of
99 and testing was successful with a 1ms frame size. The Payload Type setting is
available in the Advanced Settings menu in the Sources panel.

3. WheatNet-IP only stream audio using the AolP 1 port.

Destination Troubleshooting (Device to Tieline)

1.

Ensure the global digital input setting is configured for AolP and not AES3 via the Audio
Options panel > Digital Input Type [Audio Over IP]. To configure this via the codec front
panel press the SETTINGS > Audio Options > Dig. Input Type > AolP.

If audio is still not being received from another device double-check that the input itself is
configured for digital audio and not analog (only for inputs 1-8) in the Inputs panel. This can
also be checked via SETTINGS > Audio Inputs [Select input] > Type > Digital.

Confirm all settings match the device streaming audio to the Tieline codec. E.g. Audio Sampling
Rate, Audio Sampling Depth, Packet Time, Number of Channels streamed.

Confirm the stream Status is Running.

Important Note: PPMs on the AolP Destinations panel are inactive if the Digital Input
Type is not set to AES67 and the corresponding input Type is not set as Digital.

Source Troubleshooting (Tieline to Device)

1.

Ensure audio is metering on the outputs streaming to the other device. Note: When streaming in
AES67 mode, the Matrix Editor hard coded output channel assignments used to feed AolP
audio are dependent on the stream configuration mode selected in the Tieline codec Sources
panel. See Configuring AES67 Sources and Destinations for more details.

Confirm all settings match the device to which audio is being streamed by the Tieline codec.
E.g. Audio Sampling Rate, Audio Sampling Depth, Packet Time, Number of Channels streamed.
Confirm the stream Status is Running.

Discovery Troubleshooting

1. No SAP announcements are sent if PTP is not locked.
2. Advertisement and discovery for RAVENNA streams is only available using the AolP 1 port.
Streaming is available on both AolP 1 and AolP 2 ports.

WheatNet-IP Navigator Troubleshooting

1.

Ensure audio is routed in the codec Matrix Editor from inputs to outputs if the codec is feeding
audio into the WheatNet-IP network from codec input sources. l.e. route audio from inputs to
outputs to create a WheatNet Source from the codec.
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Download Logs for Support

Download AolP network related logs to troubleshoot any support issues:

1. Inthe AolP Web-GUI select Support and then click the Download logs button.

2. Save the file and send it to Tieline.

91

Important Note: The logs generated using the AolP Web-GUI are not the same as the

logs generated using the HTML5 Toolbox Web-GUI.
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1.14

8.

9.

Trademarks and Credit Notices

Windows is a registered trademark of Microsoft Corporation in the United States and/or other
countries.

Windows XP, Windows Vista, Windows 7, Windows 10 are either trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other countries.

Wheatnet and Wheatstone are trademarks of Wheatstone Corporation in the United States
and/or other countries.

Telos, Zephyr and Xstream are registered trademarks of Telos Systems in the United States
and/or other countries.

AXIA® and LIVEWIRE® are registered trademarks of The Telos Alliance in the United States
and/or other countries.

LIVEWIRE is a registered trademark of Axia Audio in the United States and/or other countries.
xNode is a trademark or registered trademark of The Telos Alliance in the United States
and/or other countries.

RAVENNA® is a registered trademark of ALC NetworX GmbH in the United States and/or
other countries.

Dante® is a registered trademark of Audinate Pty Ltd in the United States and/or other
countries.

10.Lawo is a registered trademark of LAWO AG in the United States and/or other countries.
11.Wi-Fi® and Wi-Fi Protected Access® (WPA) are registered trademarks of Wi-Fi Alliance.
12. Other product names mentioned within this document may be trademarks or registered

trademarks, or a trade name of their respective owner.

13.MPEG audio technologies licensed by Fraunhofer 11S. (http://www.iis.fraunhofer.de/audio)
14.Riedel is a registered trademark of Riedel Communications International GmbH in the United

States and/or other countries.
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